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About this Guide

This guide is for users of My webMethods, a web-based administration and monitoring
user interface for managing your webMethods components. It provides procedures for
navigating and using the basic features of My webMethods, including how to access
pages for webMethods components and how to use workspaces.

For a list of webMethods components and associated tasks that are available in My
webMethods, see "Application Selections Available in the Navigate Tab" on page 22.
For complete information about how to perform the tasks that use these webMethods
components, see the appropriate guide for the component. The table that lists the
available tasks also includes the titles of the guides where you can find more information
about a tasks.

Software AG Command Central
Software AG Command Central is a tool that release managers, infrastructure engineers,
system administrators, and operators can use to perform administrative tasks from
a single location. Command Central can assist with the following configuration,
management, and monitoring tasks:

Infrastructure engineers can see at a glance which products and fixes are installed,
and where. Engineers can also easily compare installations to find discrepancies.

System administrators can configure environments using a single web UI, command-
line tool, or API so maintenance can be performed with a minimum of effort and
risk.

Release managers can prepare and deploy changes to multiple servers using
command-line scripting for simpler, safer lifecycle management.

Operators can monitor server status and health, as well as start and stop servers
from a single location. They can also configure alerts to be sent to them in case of
unplanned outages.

For more information about Software AG Command Central, see the Command Central
documentation.

Document Conventions

Convention Description

Bold Identifies elements on a screen.
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Convention Description

Narrowfont Identifies storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE Identifies keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic Identifies variables for which you must supply values specific to
your own situation or environment. Identifies new terms the first
time they occur in the text.

Monospace
font

Identifies text you must type or messages displayed by the
system.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).

Online Information
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at hp://
documentation.softwareag.com. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support
website at hps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability,
and download products, go to Products.

http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
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To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at hp://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com
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About Logging Into and Out of My webMethods
My webMethods is a web-based, monitoring and administration user interface for
managing your webMethods components. When you log into My webMethods, you are
logging into all webMethods components that are incorporated into My webMethods.
Your user name and password will be the same for all underlying webMethods
components.

For example, if you have and webMethods Optimize for Process installed, when you log
into My webMethods, the system automatically logs you into both webMethods Monitor
and Optimize for Process with a single login. When you log out of My webMethods, My
webMethods logs you out of all underlying webMethods components.

Logging Into My webMethods
My webMethods has a user interface that you access via a web browser.

Important: Because My webMethods uses JavaScript and cookies, you must ensure that
your web browser is set up to allow cookies and allow JavaScript to execute.

To log into My webMethods

1. Access the My webMethods Login page by entering a URL in a web browser:

http://host :port

where:

host  is the host name of the machine on which My webMethods Server is
installed.

port  is the port on which My webMethods Server listens for incoming requests.
The default port for My webMethods is 8585.

For example, if the host name is rubicon.company.com and it uses the default
port (i.e., 8585), enter the following URL:

http://rubicon.company.com:8585

2. On the Login page, type your My webMethods user name and password. The user
name is case insensitive.

Note: When logging in, the value you specify in the user name is case insensitive.
However, after logging in, My webMethods uses the case of the user name
that is defined in your user account. For example, if the user account is
defined as “Administrator”, you can log in using “administrator”. When
My webMethods needs to use the user name, for example, for HTTP
authentication, it will use the version defined in the user account, which is
“Administrator”.
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Note: For instructions about how to change your My webMethods password, see
"Changing Your Password" on page 13.

3. Click Log In.

The first time you log in, My webMethods displays the Welcome workspace. On
subsequent logins, the page My webMethods displays depends on your user
preferences. For more information, see " My webMethods User Preferences" on page
47 and "Seing Your User Preferences" on page 45.

My webMethods provides an extremely flexible framework for granting or
restricting user access to virtually every aspect of the My webMethods interface.
Administrators assign permissions known as access privileges and functional
privileges.

Access privileges define the application pages you can display. If this guide lists
pages and/or menu items that you cannot access, it is likely because you do not
have the access privileges to view the page.

Functional privileges define the actions you can perform in My webMethods.
If this guide lists user interface controls (for example, buons) that you do not
see, it is likely because you do not have the functional privileges to perform the
actions associated with the user interface controls.

If you have any questions about your access and functional privileges, talk to your
My webMethods administrator.

Logging Out of My webMethods
Perform the following procedure to log out of My webMethods.

To log out of My webMethods

Click the Logout link, which is located at the top of all My webMethods pages.

Changing Your Password
Change your password by editing the fields on the User Information tab of your profile.

Note: You can only use this procedure to change your password if the user account
is defined in My webMethods, that is, the “System” directory service. If your
user account is defined in an external directory management system, for
example LDAP, you must change the password from the external directory
management system.

To change your My webMethods password

1. Click the My Profile link, which is located at the top of all My webMethods pages.
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2. On the User Information tab, type your new password in the Password field.

3. In the Confirm Password field, type your new password again for confirmation.

4. Click Save.

5. If you do not need to make any further changes to the profile, click  on the My
Profile tab to close the page.
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My webMethods User Interface
The following shows a sample of the My webMethods user interface:

logged in user My webMethods always displays the user name of the logged in
user at the top of the page.

standard links The standard links provide access to your My webMethods profile
and information about the version of My webMethods and the
webMethods products in use. There is also a standard link to
log out of My webMethods.My webMethods always displays
standard links at the top right of the page. For more information,
see "Standard Links" on page 18.

refresh icon Click this icon to have My webMethods refresh the navigation
pane.

collapse/
expand icon

This icon hides and restores the navigation pane. For more
information, see "Resizing the Content Area and Navigation
Pane" on page 18.
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navigation
pane

The navigation pane contains two tabs:

Navigate tab to provide access to application pages and
workspaces. For more information, see "Navigation Pane" on
page 21, "Application Selections Available in the Navigate
Tab" on page 22, and "Workspace Selections in the Navigate
Tab" on page 33.

Tools tab, which lists resources that users can add to
workspaces. For more information, see "Navigation Pane" on
page 21 and "Workspace Tools Section of the Tools Tab" on
page 36.

tabs My webMethods displays a tab for each open application page
and workspace. To make an application page or workspace the
current page so that you can view it, you click its tab. For more
information, see "Tabs" on page 19.

New tab The New tab allows you to quickly create a new workspace. For
more information, see "Creating New Empty Workspaces" on
page 55.

tab finder The tab finder allows you to navigate to open tabs. This control is
useful when you have many open tabs, and as a result, some are
not visible. For more information, see "Displaying a Page When
its Tab is Not Visible" on page 20.

resize icon The resize icon allows you to resize the navigation pane and
content area. This icon is not always visible. My webMethods
displays the resize icon when you place your mouse in the gap
between the navigation pane and the content area. For more
information, see "Resizing the Content Area and Navigation
Pane" on page 18.

content The area where My webMethods displays the content of an
application page or workspace. For more information, see
"Format of Application Pages" on page 37 and "Format of
Workspace Pages" on page 38.

window finder The window finder allows you to make a window that is open in a
workspace the current window. This control is useful when you
have many open windows. For more information, see "Finding
Windows in a Workspace" on page 74.
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Resizing the Content Area and Navigation Pane
If you need more space for the page content, you can increase its size by reducing the
size of the navigation pane or by completely hiding the navigation pane, allowing the
content area to use the entire width of the web browser window.

To resize the content area and navigation pane

1. To make the content area wider while making the navigation pane narrower:

a. Move your mouse to the gap between the navigation pane and the content area.

My webMethods displays the resize icon, .

b. Click  and drag it to the left to increase the size of the content area, while
making the navigation pane narrower.

2. To make the navigation pane wider while making the content area narrower:

a. Move your mouse to the gap between the navigation pane and the content area.

My webMethods displays the resize icon, .

b. Click  and drag it to the right to increase the size of the navigation pane, while
making the content area narrower.

3. To hide the navigation pane completely allowing the content area to use the entire
width of the web browser window, click the collapse icon, , which is on the left of
the Navigate tab.

4. To restore the navigation pane so that it is visible again, click the expand icon, ,
which is on the left side of the page.

Standard Links
The following table describes the standard links that appear at the top of every page of
My webMethods.

Use this link... To...

My Profile Access your profile. You use your profile to change your
password and specify user information, and preferences. For
more information about your profile, see "Viewing and Updating
Your My webMethods Profile" on page 41.

Help Indicates where to find documentation for the webMethods
components that are incorporated into My webMethods.
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Use this link... To...

About Lists the version of My webMethods and information about the
webMethods components that are in use with My webMethods.

Logout Log out of My webMethods. For more information, see "Logging
Out of My webMethods " on page 13.

Tabs
My webMethods displays tabs above the content area for each open application page
and workspace. The tab lists the name of the application page or workspace.

The following illustrates features of the tabs:

scroll left
and scroll
right

My webMethods displays the scroll arrow tabs when the width of
the content area is too narrow to fit the tabs for all open application
pages and workspaces. Use the arrow tabs to scroll left and right to
view additional tabs. For more information, see "Displaying a Page
When its Tab is Not Visible" on page 20.

close tab My webMethods displays the Close icon on all tabs. Click this icon
to close the application page or workspace, and as a result, remove
the tab. For more information, see "Closing Tabs" on page 20.

menu My webMethods displays the menu icon on the current tab. The
menu items that are available will differ based on whether it is a tab
for an application page or a workspace.

New tab The New tab allows you to quickly create a new workspace. For
more information, see "Creating New Empty Workspaces" on page
55.

tab finder The tab finder allows you to navigate to open tabs. This control is
useful when you have so many open tabs that some are no longer
visible. For more information, see "Displaying a Page When its Tab
is Not Visible" on page 20.
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Closing Tabs
When you no longer need an application page or workspace open, you can close the tab
associated with that page or workspace.

To close tabs

To close a single tab that is not the current tab, click Close on the tab you want to
close.

To close a single tab that is not currently visible, open the tab finder by clicking 
and then click  in the tab finder for the tab you want to close.

To close the current tab, you can use either of the above methods, or you click
 Menu on the current tab and select Close.

To close all tabs except the current tab, on the current tab click Menu and select
Close All Others.

Displaying a Page When its Tab is Not Visible
When you have many application pages and workspaces open, My webMethods might
be unable to display the tabs for all the open pages. You can display the application page
or workspace associated with a hidden tab by either scrolling the tabs or by using the tab
finder control.

To display a page when its tab is not visible

1. If you know that tab is to the left of the currently visible tabs, click the left arrow tab
 to scroll the tabs to the left. When the tab for the application page or workspace

you want to view is visible, click it to make it the current page.

2. If you know that tab is to the right of the currently visible tabs, click the right
arrow tab  to scroll the tabs to the right. When the tab for the application page or
workspace you want to view is visible, click it to make it the current page.

3. If you are unsure where the tab is located or want to quickly and easily locate any
tab, use the tab finder:

a. Click the tab finder icon .

b. Select the page you want to view from the list.

Re-arranging the Order of the Tabs
You can re-arrange the tabs by dragging a tab to a new location in the tab list.
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Navigation Pane
The navigation pane is on the left side of the user interface. It contains two tabs: the
Navigate tab and the Tools tab.

On the Navigate tab, My webMethods highlights the entry for the application page or
workspace that it is currently displaying in the content area.

The Navigate tab has two sections: Applications and Workspaces.

The Applications section provides access to the application pages, and it is further
divided into two sections: the Monitoring section, which lists pages for monitoring
webMethods components and Administration, which lists pages that allow you to
administer webMethods components.

The selections in the Applications section might differ based on the webMethods
products installed and the permissions you are assigned. Additionally, My webMethods
administrators can add custom pages to the navigation. For information about the
Applications section, see "Application Selections Available in the Navigate Tab" on page
22. For information about permissions management and customizing the navigation,
see Administering My webMethods Server.

The Workspaces section provides access to workspaces. You can add entries to the
navigation for workspaces that you have created and/or workspaces that other users
have created and have shared with you. For more information about workspaces, see
"Working with My webMethods Workspaces" on page 53.

The Tools tab lists resources that users can add to workspaces.
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The selections listed in the Tools tab might differ based on the permissions you are
assigned. Additionally, My webMethods developers can add additional tools that are
specific to your site.

As installed My webMethods provides tools in the Workspace Tools section of the tab.
For information about the selections in the Workspace Tools section, see "Workspace
Tools Section of the Tools Tab" on page 36. For information about permissions
management and customizing the tools, see Administering My webMethods Server.

Application Selections Available in the Navigate Tab
The selections in the Applications section of the Navigate tab in My webMethods are
determined by both the following:

webMethods components that are installed.

Functionality to which you have been granted access. For more information, see
Administering My webMethods Server.

The following sections list the possible Monitoring and Administration selections that are
available in the Navigate tab, provides a description of each selection, and indicates the
webMethods component(s) required for My webMethods to include the selection in the
navigation pane.

Note: For a list of the webMethods components you have installed, click the About
link, which is one of the standard links at the top of all My webMethods
pages.
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Monitoring Section of the Navigate Tab
The following tables list all possible selections in the Monitoring section of the Navigate
tab along with the webMethods component(s) that must be installed before My
webMethods includes the selection in the navigation pane.

Monitoring Selection: System-Wide

System-Wide Sub-items Required webMethods components

Problems to locate problems with process
instances and to view information
related to the KPI rules that a process
instance has violated. Additionally, use
Problems to view problems where system
components are out of compliance and to
view information about the event rules
and threshold rules that were violated.

Optimize for Process

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Analytics Overview to view a summary
of all system components. Use this task
to view the performance of the entire
system at a high level.

Optimize for Infrastructure

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Monitoring Selection: Business

Business Sub-items Required webMethods components

Collaboration Processes to search for and
view currently running collaboration
processes that users start when creating a
collaboration task.

Task Engine

For more information, see
webMethods Task Engine User’s Guide.

Process Analytics to analyze information
about the performance of processes.

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Business Overview to monitor and analyze
Trading Networks transaction data.

Optimize for B2B

For more information, see
webMethods Optimize for B2B User’s
Guide.
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Business Sub-items Required webMethods components

Process Instances to view details about
individual process instances, including
drilling down to view information about
steps within a process. You can also
use this link to suspend and resume
processes.

Monitor

Optimize for Process

For more information, see the
webMethods Monitor User’s Guide or
webMethods Optimize User’s Guide.

Tasks to view and manage tasks in My
webMethods. Within this selection, you
can navigate to:

My Inbox to view tasks assigned to you.

Task List Management to monitor and
manage running tasks. Use the task list
to suspend, resume, assign, delegate,
and resubmit tasks, among other
activities.

Task Charts to view basic task charts.

[Task Type] to view a custom inbox
showing all of the tasks of this type that
are assigned to you (there is a separate
[Task Type] selection for each type of
task assigned to you).

Trading Networks

My webMethods Server

For more information, see
webMethods Task Engine User’s Guide.

Six Sigma Summary to view six sigma
information for process instances.

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Monitoring Selection: Integration

Integration Sub-items Required webMethods components

B2B to monitor Trading Networks
transactions and other data related to
exchanging data with trading partners.
Also to set Trading Networks-specific My
webMethods preferences.

Transactions to track and manage
documents that Trading Networks has
processed.

Trading Networks

For more information, see
webMethods Trading Networks User’s
Guide.
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Integration Sub-items Required webMethods components

Tasks to view the status and details of
delivery and service execution tasks
that Trading Networks creates when
processing documents.

Activity Log to view log entries for
activities occurring within the Trading
Networks system.

User Preferences to set Trading
Networks-specific user preferences.

Services to view log data that an
Integration Server has logged for a
service and to resubmit services.

Monitor

For more information, see
webMethods Monitor User’s Guide.

Documents to view and resubmit
documents that have been logged to the
logging database.

Monitor

For more information, see
webMethods Monitor User’s Guide.

Administration Section of the Navigate Tab
The following tables list all possible selections in the Administration section of the
Navigate tab along with the webMethods component(s) that must be installed before My
webMethods includes the selections in the navigation pane.

Administration Selection: Messaging

Messaging Sub-items Required webMethods components

Broker Servers to manage and
monitor webMethods Broker Servers,
webMethods Brokers, document types,
client groups, and clients.

BrokerTerritories to create and manage
territory webMethods Brokers and
territory gateways.

BrokerClusters to create and manage
cluster webMethods Brokers and cluster
gateways.

webMethods Broker

For more information, see
Administering webMethods Broker.
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Messaging Sub-items Required webMethods components

Naming Directories to create and configure
administered objects used by JMS.

Settings to configure parameters relating
to the operation of the webMethods
Broker user interface on My webMethods

Log to view error and activity messages
generated by the webMethods Broker
user interface.

Administration Selection: System-Wide

System-Wide Sub-items Required webMethods components

webMethodsContent Configurator to view
the available webMethods Content
Service Platform servers, and to create
and manage content listeners and filters
for those servers.

webMethods Content Service
Platform

For more information, see
Implementing webMethods Content
Service Platform for BPM.

Permissions Management to manage access
privileges and functional privileges that
you assign to users, groups, and/or roles.

My webMethods Server

For more information, see
Administering My webMethods Server.

User Management to manage users, groups,
and roles. Within this selection, you can
navigate to:

Roles to add, edit, and delete roles.

Groups to add, edit, and delete groups.

User to add, edit, and delete users.

Certificates to manage authentication
certificates.

My webMethods Server

For more information, see
Administering My webMethods Server.

Calendars Management to configure and
manage calendars. Within this selection
you can navigate to:

Business Calendars to add, edit, and
delete business calendars.

Task Engine

For more information, see
webMethods Task Engine User’s Guide.
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System-Wide Sub-items Required webMethods components

User Calendars to add, edit, and delete
user calendars.

Workspace Management to manage and
manipulate all workspaces within My
webMethods.

My webMethods Server

For more information, see
Administering My webMethods Server.

Environments to configure environments
for Optimize for Process and Optimize
for Infrastructure. Within this selection,
you can navigate to:

Database Pool Configuration to maintain
a common list of database pools for
webMethods servers in an environment.

Define Environments to define
environments and common
configurations for Optimize for Process
and Optimize for Infrastructure
components.

webMethods Broker

Optimize for Infrastructure

Optimize for Process

My webMethods Server

For more information, see
Configuring BAM.

System Information to:

Set up logging, and view information
about the Analytic Engines, Web Service
Data Collectors, and Prediction Engine.

View information for common
configuration environments. You
can view the operational status
and component ID, host and port
information for a components in your
webMethods environments.

Optimize for Infrastructure

Optimize for Process

For more information, see
Administering webMethods Optimize
and Configuring BAM.

B2B Permissions to manage permissions
that control access to Trading Networks
data and actions. Within this selection,
you can navigate to:

Data Permissions to identify data sets
and indicate the actions roles can take
against Trading Networks data in the
data sets.

General Functional Permissions to indicate
the Trading Networks actions that roles

Trading Networks

For more information, see
webMethods Trading Networks
Administrator’s Guide.
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System-Wide Sub-items Required webMethods components
can perform. These permissions govern
Trading Networks data not covered by
data permissions.

Administration Selection: Analytics

Analytics Sub-items Required webMethods components

Rules to manage KPI, event, and
threshold rules. Within this selection, you
can navigate to:

Rule List to create rules to notify you
when a process or resource becomes
problematic and requires user aention.

Rule Filters to edit data collection filters.

Rule Audit to view complete auditing
details for every rule-related change in
your system.

Optimize for Infrastructure

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

KPIs to configure Key Performance
Indicators (KPIs). Within this selection,
you can navigate to:

Business Data to configure KPIs for
business data.

System Data to configure KPIs for system
data.

Dimensions to define dimensions.

KPI Hierarchies to view a graphical
hierarchy of your system components to
help you understand the hierarchy and
interdependency of these components.

Intelligent Links to configure dynamic
links to Web pages inside or outside of
My webMethods and display those links
on appropriate pages.

Optimize for Infrastructure

Optimize for Process

For more information, see
Administering webMethods Optimize.

Data Management to extract Optimize
assets and purge data from the Optimize
Analysis and Process Tracker database

Optimize for Infrastructure

Optimize for Process
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Analytics Sub-items Required webMethods components
components. Within this selection, you
can navigate to:

Asset Extraction to extract various
Optimize assets (such as dimensions
and event maps), save them to your
file system, and later deploy them to
another Optimize Analytic Engine.

Live Purge to purge data from the
Optimize Analysis and Process Tracker
database components.

For more information, see
Administering webMethods Optimize.

Infrastructure Components to configure
components of the system, such
as Integration Servers, that are
automatically monitored.

Optimize for Infrastructure

Optimize for Process

For more information, see
Administering webMethods Optimize.

Prediction to create prediction templates. Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Diagnostics to view information to
troubleshoot issues with event maps,
dimensions, hierarchies, KPIs, and rules.

Optimize for Infrastructure

Optimize for Process

For more information, see
webMethods Optimize User’s Guide.

Job Management to view activities of the
Job Manager, which coordinates system
activities.

Job Audit to view summary information
about all jobs scheduled with the Job
Manager.

Job Queue to view the status of all jobs
scheduled with the Job Manager.

Optimize for Infrastructure

Optimize for Process

For more information, see
Administering webMethods Optimize.
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Administration Selection: Business

Business Sub-items Required webMethods components

webMethodsBusiness Rules to dynamically
update business rules created with
the Rules Development feature in
Software AG Designer.

webMethods Rules Development

For more information, see
webMethods BPM Rules Development
Help.

Business Processes to access and modify
detailed process model information,
and to identify the process models that
you want to monitor using Monitor and
Optimize for Process.

Monitor

Optimize for Process

For more information, see
webMethods Monitor User’s Guide or
Administering webMethods Optimize.

Business Processes Dashboard to quickly
access and modify key information
about a process model. For example, is
it enabled, how many instances exist, or
how many are running and failed? Click
a process link to open an editable dialog
box with key process model aributes.
Hover the cursor over the process name
to view a pop-up process diagram.

Monitor

For more information, see
webMethods Monitor User’s Guide.

Data Management to archive and delete
logging data from the Process Audit
database and to view archive history.

Monitor

For more information, see
webMethods Monitor User’s Guide.

Tasks to administer tasks that have been
published to My webMethods Server.
From here you can:

Enable disable, delete, and start tasks.

Configure collaboration tasks.

Configure a task analytics connection.

Configure a task e-mail listener
connection.

Task Engine

For more information, see
webMethods Task Engine User’s Guide.
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Administration Selection: Integration

Integration Sub-items Required webMethods components

B2B to manage Trading Networks
partner management, manage the
archival and deletion of Trading
Networks data, and configure Business
Activity Monitoring for Trading
Networks data.

Archive Schedules to configure and
schedule the archival and deletion of
Trading Networks data.

Partner Profiles to add, edit, and delete
Trading Networks profiles and
extended profile fields.

Partner Groups to add, edit, and delete
Trading Networks partner groups.

Partner Certificates to query for partner
certificates that are expired or expiring
soon.

Public Queues to add, edit, and delete
Trading Networks public queues.

Business Monitoring to configure TN
document types for BAM (Business
Activity Monitoring) and globally
enable all the TN document types for
monitoring.

Trading Networks

Optimize for B2B

For more information, see
webMethods Trading Networks
Administrator’s Guide and webMethods
Optimize for B2B User’s Guide.

B2B Settings to set configuration seings
for Trading Networks, Module for EDI,
and Module for EDIINT.

Administrative Preferences to set
administrative seings, including
identifying the Trading Networks
server that My webMethods Server is to
interact with.

Configure Properties to set the
configuration properties of Trading
Networks, Module for EDI, and Module
for EDIINT.

Trading Networks

Module for EDI

Module for EDIINT

For more information, see
webMethods Trading Networks
Administrator’s Guide, webMethods
Module for EDI Installation and User’s
Guide, and webMethods Module for
EDIINT Installation and User’s Guide
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Integration Sub-items Required webMethods components

Submit Documents to submit XML or EDI
documents to Trading Networks.

Control Numbers to search, create, and
manage control numbers in Module for
EDI.

ESB to access Integration Server
Administrator so that you can administer
Integration Servers.

Integration Server

For more information, see
webMethods Integration Server
Administrator’s Guide.

Administration Selection: My webMethods

My webMethods Sub-items Required webMethods components

System Settings to change the host names
and port numbers that My webMethods
uses to communicate with the Integration
Server, the Analytic Engine, and the Task
Engine.

Monitor

Optimize for Infrastructure

Optimize for Process

Task Engine

For more information, see
webMethods Monitor User’s Guide,
Administering webMethods Optimize,
and webMethods Task Engine User’s
Guide.

Directory Services to configure external
directory services you want to use with
My webMethods.

My webMethods Server

For more information, see
Administering My webMethods Server.

E-mail Servers to configure the mail server
seings used by My webMethods Server
when processing e-mail messages.

My webMethods Server

For more information, see
Administering My webMethods Server.

Cluster Settings to define the URL to use
to access My webMethods in a clustered
environment and to configure different
roles of My webMethods Server clustered
nodes.

My webMethods Server

For more information, see
Administering My webMethods Server.
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My webMethods Sub-items Required webMethods components

Data Sources to connect to external data
sources, such as databases, and make
them available to My webMethods
Server.

My webMethods Server

For more information, see
Administering My webMethods Server.

Workspace Selections in the Navigate Tab
The Workspaces section of the Navigate tab provides access to workspaces. It has two
sections:

Recently Added that lists workspaces that you have recently added and saved.

My Workspaces that lists workspaces that you have added to your navigation. These
can be either workspaces that you have created or workspaces that another user has
created and shared with you. For more information, see "About Adding Workspaces
to the Navigation Pane" on page 64.

Tool Selections in the Tools Tab
The selections listed in the Tools tab might differ based on the permissions you are
assigned.

To use a tool, you drag it onto a workspace. In response, My webMethods adds a
portlet window to the workspace for the tool. For more information about using tools in
workspaces, see "Using Tools to Enhance Workspaces" on page 77 and Diagnosing
My webMethods Server.

Layout Section of the Tools Tab
The tools for layout management that My webMethods provides as installed are in the
Layout section of the tab.

Here is a brief description of the available tool:

Tool Use to...

Row Add rows to a workspace. For more information, see
Administering My webMethods Server.
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MWS Monitoring and Diagnostics Section of the Tools Tab
The tools for monitoring and diagnosing that My webMethods provides as installed are
in the MWS Monitoring and Diagnostics section of the tab.

The following tables provide a brief description of each of the tools:

MWS Monitoring and Diagnostics Section: Log Tracing and Analysis

Log Tracing and Analysis Sub-item Required webMethods components

Log Analysis Datasource to read and
analyze log files created within My
webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Analysis Time Period to configure a
time period for creating log files within
My webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Configuration to set the log message
collection criteria.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Errors by Severity to analyze and
display logs of WARNING, ERROR, or
FATAL severity.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log FATAL Issues to analyze and display
logs only of FATAL severity.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Issues to analyze and display logs of
WARNING, ERROR, or FATAL severity.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Issues by Component to analyze and
display logs by the component in which
they appear.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.
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Log Tracing and Analysis Sub-item Required webMethods components

Log Issues by Product to analyze and
display logs by the product in which they
appear.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Log Viewer to view the latest messages in
plain text log files of My webMethods
Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Most Used Portlets to display statistics
about the ten most used portlets in My
webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Most Used Web Services to display statistics
about the ten most used Web services in
My webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

SOAP Traffic Monitor to debug issues with
web service calls from other portlets.

My webMethods Server

For more information, see My
webMethods Server Portlet Reference.

MWS Monitoring and Diagnostics Section: Performance Information

Performance Information Sub-item Required webMethods components

Performance Analysis to measure
and analyze the performance of My
webMethods Server services and custom
portlets or applications.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Performance Statistics to display statistic
and analysis information about the
performance of various My webMethods
Server actions which are grouped by
categories.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Slow Database Calls to display information
about ten of the slowest database calls in
My webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.
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Performance Information Sub-item Required webMethods components

Slow Portlets to display performance
information about ten of the slowest
portlets in My webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Slow Web Services to display performance
information about ten of the slowest Web
services in My webMethods Server.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

MWS Monitoring and Diagnostics Section: System Information

System Information Sub-item Required webMethods components

Memory Monitor to monitor the memory
usage of the Java Virtual Machine (JVM)
and send notifications to administrators
when configured threshold limits are
reached.

My webMethods Server

For more information, see My
webMethods Server Portlet Reference.

Overview to view server information on
the following tabs:

System Properties

Request Properties

Session Attributes

Application Attributes

My webMethods Server

Thread Dump to monitor thread execution
deadlocks in My webMethods Server
threads.

My webMethods Server

For more information, see Diagnosing
My webMethods Server.

Workspace Context Viewer to view, add,
modify, and delete context information
about the currently displayed workspace
page.

My webMethods Server

Workspace Tools Section of the Tools Tab
The tools for workspace management that My webMethods provides as installed are in
the Workspace Tools section of the tab.
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The following table provides a brief description of each of the tools:

Tool Use to...

Attachments Aach files to a workspace. For more information, see
"Aachments Tool" on page 81.

Bookmarks Add a list of links to external web sites and links to other
workspaces. For more information, see "Bookmarks Tool" on
page 84.

Directory
Browser

Add a search window to a workspace that allows you to find
identification information about other My webMethods users.
For more information, see "Directory Browser Tool" on page
86.

HTML Text Add formaed text to a workspace. For more information, see
"HTML Text Tool" on page 87.

Image Add an image to a workspace. For more information, see "Image
Tool" on page 88.

Note Add a simple note to a workspace. For more information, see
"Note Tool" on page 90.

User Calendar Add a user’s calendar to a workspace so that you can view the
user’s availability. For more information, see "User Calendar
Tool" on page 92.

Note: You might have additional tools that a My webMethods developers has
added. Check with your system administrator or developer for information
about site-specific tools.

Format of Application Pages
The following shows the format of a typical application page.
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Title of
the page

My webMethods displays the title of the application page at the top.

If you have navigated to a subpage within a selection from the
navigation pane, My webMethods displays the title of the selection from
the navigation pane along with the title of the current page, using the
format Main Page  > Subpage .

Page
content

The format of the page content is determined by the webMethods
component that displays the page. Many pages uses similar panels for
searching for:

Users/groups/roles, for more information see "Searching for Users,
Groups, and Roles" on page 95.

Data, for more information see "Searching for Data" on page 101

Format of Workspace Pages
The following shows the format of a workspace.



M
Odd Header

Familiarizing Yourself with My webMethods

Working with My webMethods Version 9.10 39

Unsaved
changes
indicator

If you have unsaved changes in a workspace, My webMethods
displays an asterisk (*) before the workspace name on the tab.

Title of the
workspace

My webMethods displays the name of the workspace at the top.

Page content The owner of the workspace and contributors to the workspace
determine the content of the workspace. You can add windows
from application pages, windows from other workspaces, and add
tools to the workspace. For more information, see "Working with
My webMethods Workspaces" on page 53 and "Working with
Workspace Content" on page 67.
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The My webMethods Profile
The system maintains a profile for each user of My webMethods. You access your profile
via the My Profile standard link. The following table lists the seings you can update from
your profile:

Setting For more information, see...

My webMethods password "Changing Your Password" on page 13

Identity and locale "Identifying Yourself to My
webMethods " on page 42

Page to display at login "Seing Your User Preferences" on
page 45

Number of search results to display "Defining the Number of Search
Results Rows to Display Per Page" on
page 112

Whether to display confirmation
messages before completing actions,
such as before deleting a workspace

"Seing Your User Preferences" on
page 45

Business and user calendar "Calendars" on page 48

Identifying Yourself to My webMethods
Your identification information is listed on the User Information and User Profile tabs of
your profile.

User Information tab. Your name and e-mail address are on the User Information tab.

Note: You can only update the fields on the User Information tab if your
user account is defined in My webMethods, that is, the “System”
directory service. If your user account is defined in an external directory
management system, for example LDAP, My webMethods obtains values
from the external directory management system for these fields.

User Profile tab. Several fields that provide optional information that you can supply
about your identity.
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To identify yourself to My webMethods

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the User Information tab.

a. Use the First Name and Last Name fields to specify your name.

b. Optionally, type your e-mail address in the E-mail Address field.

Note: My webMethods will not be able to send you notifications if you do
not specify an e-mail address. For example, if you subscribe to a forum,
My webMethods cannot send you notifications of updates if you do not
specify an e-mail address.

3. Click the User Profile tab.

4. Specify the following optional information:

In this field... Specify...

Middle Name Your middle name.

Title Your title, for example, Mr., Mrs., or Ms. If the title you
want to use does not appear in the list, select Other. My
webMethods prompts you for the title you want to use.

Name Suffix The suffix that should appear after your name, if any, for
example, Jr., Sr., PhD, III. If the suffix you want to use does
not appear in the list, select Other. My webMethods prompts
you for the suffix you want to use.

Preferred
Language/Locale

Your language and locale. The Default selection indicates
you want to use the language installed on My webMethods
Server.

Country/Region
ID

The country where you are located.

Address 1

Address 2

Your street address.

City The city where you are located.

State/Province The state or province where you are located.
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In this field... Specify...

Postal Code Your postal code, for example, a ZIP Code if you are located
in the United States.

Country/Region
ID

The country where you are located.

Phone 1 Area
Code

Your area code.

Phone 1 Number Your phone number.

Phone 1
Extension

Your extension, if any.

Phone 1 Country
Code

The country code associated with your phone number.

Default Date
Format

The date format you want My webMethods to use when
displaying dates. For more information about date formats,
see the SimpleDateFormat class in the Oracle Java API
documentation.

Default Time
Format

The time format you want My webMethods to use when
displaying times. For more information about date formats,
see the SimpleDateFormat class in the Oracle Java API
documentation.

Default Time
Zone

The time zone that My webMethods uses when displaying
times.

Important: Changing the time zone in the Default Time Zone field
may result in the loss of transactional context, such
as search results, sorting, and details, when you
return to the page you were previously using. For
more information about how to change the time zone
without any impact on transactional context, see
"Changing the Time Zone in My webMethods " on
page 52.

Default Number
Format

The format that My webMethods uses when displaying
numbers. For more information about number formats,
see the DecimalDateFormat class in the Oracle Java API
documentation.
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In this field... Specify...

Default Currency
Format

The format that My webMethods uses when displaying
currency. For more information about currency formats,
see the DecimalDateFormat class in the Oracle Java API
documentation.

Note: Not all portlets make use of the defaults that you specify in Default Date
Format, Default Time Format, Default Time Zone, Default Number Format, and
Default Currency Format.

5. Click Save.

6. If you are done updating your profile, close the My Profile tab. For instructions, see
"Closing Tabs" on page 20.

Setting Your User Preferences
The User Preferences tab contains miscellaneous My webMethods preferences that you
can set for your interaction with My webMethods. This section describes how to set the
preferences that My webMethods provides as installed. For more information about
these preferences, see " My webMethods User Preferences" on page 47. The My
webMethods administrator can remove preferences and/or add additional preferences.
As a result, your preferences might be different.

To set your user preferences

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the User Preferences tab.

3. To identify the application page, workspace, or tab that you want My webMethods
to display when you log into My webMethods, do one of the following:

To identify an application page that you want My webMethods to display:

i. In the Start Page field, click Application Page.

ii. Navigate to the page you want displayed by clicking the links in the Name
column.

iii. When the page you want displayed is in the list, select it.

iv. Click Apply.

v. Click Save.

To identify a workspace that you want My webMethods to display:

i. In the Start Page field, click Workspace.
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ii. Use the search fields to search for the workspace that you want displayed and
click Search.

iii. In the results, select the workspace that you want displayed.

iv. Click OK.

v. Click Save.

To indicate that you want My webMethods to display the last active tab from
your last session at login:

i. In the Start Page field, click Clear.

ii. Select the Open Last Active Tab on Login check box.

iii. Click Save.

4. To indicate whether you want My webMethods to prompt you to confirm actions,
perform the following steps:

a. If you want My webMethods to prompt you to confirm the deletion of a
workspace, select the Show Delete Workspace Confirmation check box. If you want
My webMethods to immediately delete a workspace with no confirmation, clear
the check box.

b. If you want My webMethods to prompt you to confirm the deletion of a window
from a workspace, select the Show Delete Window Confirmation check box. If you
want My webMethods to immediately delete a window with no confirmation,
clear the check box.

c. If you want My webMethods to prompt you to confirm a request to close all tabs
except the current one, select the Close All Tabs Confirmation check box. If you want
My webMethods to immediately close tabs with no confirmation, clear the check
box.

d. Click Save.

5. To identify the default number of rows that you want My webMethods to display
in windows that list items in rows, for example, in search results, select one of the
following in the Items Per Page field and click Save.

Default to allow My webMethods to determine the number of items to display per
page.

A number to indicate the number of items you want My webMethods to display
per page.

Show All to have My webMethods display all items on a single page.

6. If you want My webMethods to automatically save changes to a workspace when
you select to view another workspace or application page, select the Auto-Save when
Navigating to a Different Workspace check box. If you want My webMethods to prompt
you to save changes before displaying another workspace or application page, clear
the check box.
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7. If you want My webMethods to perform full-page refreshes rather than
asynchronous refreshes, select the Bypass Full Page Refreshes When Possible check box.

8. If you are done updating your profile, close the My Profile tab. For instructions, see
"Closing Tabs" on page 20.

My webMethods User Preferences
The following table lists the preferences that My webMethods provides as installed. For
instructions on how to set these preferences, see "Seing Your User Preferences" on page
45.

Preference Description

Start Page Indicates the application page or workspace that you
want My webMethods to display when you initially
log into My webMethods. This seing overrides the
Open Last Active Tab on Login preference.

If Start Page is set, at login My webMethods displays
the page identified by the Start Page preference. This
preference takes precedence over the Open Last Active
Tab on Login preference.

If Start Page is not set, but Open Last Active Tab on Login
is set, at login My webMethods displays the last
active tab from your last session.

If neither the Start Page nor Open Last Active Tab on
Login are set, at login My webMethods displays a
blank workspace in a new tab.

Open Last Active Tab on
Login

Identifies whether you want My webMethods to
display the last active tab from your last session
at login. The Start Page preference overrides this
preference. For more information about how the two
preferences work together, see the description of the
Start Page preference.

Items Per Page Indicates the default number of rows that My
webMethods displays, for example, in search results.

Show Delete Workspace
Confirmation

When you delete a workspace, this preference indicates
whether you want My webMethods to prompt you to
confirm the action. When this check box is cleared and
you delete a workspace, My webMethods immediately
deletes the workspace without asking for confirmation.
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Preference Description

Show Delete Window
Confirmation

When you delete a window from a workspace,
this preference indicates whether you want My
webMethods to prompt you to confirm the action.
When this check box is cleared and you delete
a window from a workspace, My webMethods
immediately deletes the window without asking for
confirmation.

Show Close All Tabs
Confirmation

When you request that My webMethods close all
tabs except the current one, this preference indicates
whether you want My webMethods to prompt you
to confirm the action. When this check box is cleared
and you request to close all tabs, My webMethods
immediately closes the tabs without asking for
confirmation.

Auto-Save when
Navigating to a Different
Workspace

When you are viewing a workspace that has changes
that have not yet been saved and click a tab to view
another workspace or application page, the preference
indicates whether you want My webMethods
to automatically save the changes to the current
workspace before displaying the selected workspace
or application page. When this check box is cleared,
My webMethods prompts you to ask if you want
the changes saved before displaying the selected
workspace or application page.

Bypass Full Page
Refreshes when possible

When you make a change to a page and apply the
changes, My webMethods asynchronously refreshes
only the portion of the page that you have modified.
When this check box is cleared, My webMethods
refreshes the full page.

Calendars
The My webMethods profile contains calendar information that the Task Engine uses to
assist with task definition and behavior.

The two types of calendars are business calendars and user calendars.

Business calendars define standard business days and hours for your organization,
including holidays, weekends, and other times when your organization is not
conducting business. An administrator configures the business calendars. For
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example, an administrator might configure a business calendar for normal business
hours of Monday through Friday, 8:00 A.M. to 5:00 P.M. Eastern Standard time.

An administrator can configure multiple business calendars. For example, if your
organization has different shifts, an administrator can configure a business calendar
for each shift. Another reason for multiple business calendars might be if your
organization spans multiple time zones; an administrator can configure a business
calendar for each time zone.

If an administrator has configured business calendars, in your My webMethods
profile, you can select the business calendar that best fits your working hours so that
the Task Engine can determine your business hours and schedule tasks accordingly.
For instructions, see "Defining Your Business Calendar" on page 49.

User calendars are calendars that a third-party application maintains, for example,
a Microsoft Outlook calendar or Lotus Notes calendar. An administrator must
configure the My webMethods Server so that it can access the user calendars. You
maintain your calendar in the third-party application to define your availability.
As a result, the Task Engine can determine your individual availability when
scheduling tasks. Also, you can view a read-only version of your calendar within My
webMethods. For instructions, see "Viewing Your Personal User Calendar" on page
50.l

Note: If an administrator configures the use of user calendars, you can also use
the User Calendar tool in a workspace to display your availability or the
availability of another My webMethods user by adding a user calendar
to a workspace. For more information, see "User Calendar Tool" on page
92.

Defining Your Business Calendar
On the Calendar tab of your profile, you can define the business calendar to use for
your user account. By default, My webMethods uses the default calendar that the
administrator creates.

Note: You can only select a business calendar for your user account if an
administrator has previously configured business calendars.

To define your business calendar

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the Calendar tab.

3. In the User Business Calendar panel, in the Business Calendar list, select the calendar to
use for your user account.

4. Click Save.
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Viewing Your Personal User Calendar
On the Calendar tab of your profile, you can view your user calendar, which shows your
availability. The user calendar displays the calendar that you maintain in a third-party
application, such as Microsoft Outlook or Lotus Notes.

Note: You can only view your personal user calendar if an administrator has
previously configured My webMethods Server to access user calendars from a
third-party application.

To view your user calendar

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the Calendar tab.

My webMethods displays your user calendar in the User Personal Calendar panel. If an
administrator has not configured My webMethods Server to access user calendars, My
webMethods displays a message indicating that user calendars are not available.
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Changing the Time Zone in My webMethods
By default, My webMethods Server displays times in your local time zone based on
browser locale. Although you can change the time zone from the default one in your
profile in My webMethods, doing so may result in the loss of transactional context, such
as search results, sorting, and details, when you return to the page you were previously
using.

Use the following procedure to change the time zone on any page in My webMethods
without losing transactional context.

To change the time zone in My webMethods

1. On any page in My webMethods, in the boom left corner of the page, click the time
zone link next to All times.

2. In the Timezone field of the Select Timezone dialog box, select a time zone from the
drop-down list.

3. Click Apply.

The My webMethods page refreshes automatically showing the existing data, but any
times on the page are updated to reflect the new time zone. For example, if you search
for tasks in your inbox and then you change the time zone on the My Inbox page, the
dates associated with the tasks are updated to reflect the new time zone.
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About Workspaces
A workspace is a page where you add the content that you want. You can add:

Tools that My webMethods provides, for example, the Aachments tool that allows
you to aach files to a workspace. For more information about tools that My
webMethods provides, see "Using Tools to Enhance Workspaces" on page 77.

Custom tools that a developer at your site has created and added to My webMethods.

Windows from application pages. As you work with My webMethods, you navigate
through the user interface to display information that you need or that you are
interested in. My webMethods displays the information in the user interface using
portlet windows. When you encounter information that is vital for you or that you
frequently use, you can add it to a workspace. The windows that you add maintain
their context when the system displays them in a workspace. For example, if you
select to add a monitor that is displaying order cycle time to a workspace, when
you view the workspace, the window will display the monitor specifically for order
cycle.

Windows from other workspaces. If you are viewing a workspace and want a copy of a
window that is in one workspace in another workspace, you can copy it.

For more information about managing the content in a workspace, see "Working with
Workspace Content" on page 67.

You can create as many workspaces as you need. You can share your workspaces
with other users or use workspaces that other users have shared with you. When a
workspace is shared, the owner sets the permissions that define the actions users can
take against the workspace. For example, you might share one of your Workspaces and
only allow users to view the content, but not modify it. For more information about
sharing workspaces, see "Workspace Sharing" on page 60.

Use workspaces to group related information. Examples of uses for workspaces might
be to:

Group information and tools that you frequently use in one location. For example, you
might be involved with several projects and want to create a separate workspace for
each project.

Troubleshoot an issue. You can add information related to the issue to a workspace.
You might want to share the workspace with other users that are involved in the
issue. You can add tools, such as the Discussion Topics tool, to facilitate discussions
about the issue with other users.

Organize the work you need to do for tasks. For example, in My webMethods you might
display your task inbox and search for specific tasks. You can add the search results
to a workspace. Then you can add additional tools or windows from application
pages that you need to accomplish the tasks.
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About Creating New Workspaces
When creating a new workspace, you can either create:

An empty workspace

A workspace that is a copy of an existing workspace

To copy an existing workspace, you use “save as” functionality to save an
existing workspace using a new name. As you make changes to the new and
original workspaces, My webMethods does not synchronize the changes. The two
workspaces are distinct.

Creating New Empty Workspaces
To create new empty workspaces

1. Click the New tab, which My webMethods always displays as the last visible tab
above the content area.

My webMethods displays an empty workspace with a default name. To change the
name, see "Renaming Workspaces" on page 59.

2. Click Menu on the tab for the new workspace and select Save Workspace.

Using “Save As” to Create a New Workspace
To create a new workspace that is a copy of an existing workspace

1. Open the workspace that you want to use as the base for the new workspace. For
instructions, see "Opening Workspaces" on page 57.

2. Click Menu on the tab for the workspace and select Save As.

3. In the Save Workspace As window in the New Workspace Name field, type the name
you want to use for the new workspace.

4. Click OK.

Defining the Layout of a Workspace
To define how the windows within a workspace can be positioned, define the workspace
layout. There are two types of layouts:

Column layout. In this layout, all the windows in a workspace are aligned in columns.
Windows cannot overlap within a column. You can define a workspace to have one,
two, three, or four columns.
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Free Form layout. In this layout, you can place windows on the workspace in any
location. Windows can overlap and even completely cover one another. This is the
default for a new workspace.

For instructions for adding windows to a workspace, see:

"Adding Tools to a Workspace" on page 68

"Adding Windows from Application Pages to a Workspace" on page 68

"Adding Windows from a Workspace to Another Workspace" on page 70

For instructions for how to position windows within a workspace, see "Positioning
Windows in a Workspace" on page 75.

Note: To define or update the layout for a workspace you must either be the
owner of the workspace, or if you are using a workspace that another user
has shared with you, you must have “View and Modify” or “Full Control”
permissions to the workspace. If you have “View Only” permission to a
workspace, you can change the layout; however, you cannot save the changes;
as a result, when you leave the workspace, it will revert to its previous state.
For more information about sharing workspaces, see "Sharing Workspaces"
on page 62.

To define the layout of a workspace

1. Click Menu on the tab for the workspace and select Workspace Properties.

2. Select the Layout tab.

3. From the Columns list, select layout that you want to use for the workspace.

4. If you select One Column, Two Columns, Three Columns or Four Columns, you can set
additional properties for each column in the layout.

a. In the Width field type the percentage of the workspace to use for the column. By
default the percentages are set for evenly spaced columns.

b. Select the Word Wrap check box if you want My webMethods aempt to wrap
long text lines within windows in the workspace to fit the window size. Clear the
check box if you do not want long lines to wrap.

Allowing long lines to wrap helps to beer fit windows within columns.

c. From the Horizontal Alignment list select how the windows should be aligned
horizontally in the column. By default, My webMethods left aligns the windows
in each column.

d. From the Vertical Alignment list select how the windows should be aligned
vertically in the column. By default, My webMethods aligns the windows at the
top of each column.

5. Click OK.
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6. Click Menu on the tab for the workspace and select Save Workspace to save your
changes.

Opening Workspaces
You can open workspaces that you own and workspaces that other users own and
have shared with you. For more information about shared workspaces, see "Sharing
Workspaces" on page 62.

To open a workspace

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section of the Navigate tab, browse to and click the name of the
workspace you want to open.

Note: If the workspace you want to open is not in the navigation pane, you can
search for and add it to the navigation. For more information, see "About
Adding Workspaces to the Navigation Pane" on page 64.

Workspace Properties
You can open the properties of a workspace to view or set them. The properties are
grouped on the following tabs:

General tab, which lists properties, such as the workspace name and description. For
a list and description of each general property, see the table below.

Layout tab, which you can use to define how windows can be positioned in a
workspace. For more information, see "Defining the Layout of a Workspace" on page
55.

The following table describes the properties on the General tab.

Section Property Description

Name The name of the workspace.

For instructions for changing the workspace name,
see "Seing General Properties for a Workspace"
on page 58 and "Renaming Workspaces" on
page 59.

General

Description A description for the workspace.
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Section Property Description

Note: Currently the description is only listed in the
properties and is not used by My webMethods
for any specific purpose.

For instructions for changing the workspace
description, see "Seing General Properties for a
Workspace" on page 58.

Keywords Keywords that you assign to a workspace that you
can later use when searching for a workspace.

For instructions for defining keywords for a
workspace, see "Seing General Properties for a
Workspace" on page 58.

Owner The user name of the user that owns the
workspace.

Created On The date and time the workspace was created.

Modified On The date and time of the last time the workspace
was updated.

Maintenance

Aliases This property is intended for expert users. A
workspace can have zero, one, or more aliases.
An alias defines an alternative way to access a
workspace. Workspace developers might need
to add aliases if they are building complex multi-
page applications and need to refer to workspaces,
for example, when creating navigation from one
page to another and need to pass parameters to a
specific workspace. For more information about
aliases, see Administering My webMethods Server.

Setting General Properties for a Workspace
Use the following procedure to view and/or set the general properties for a workspace.
For a description of the properties on the General tab, see "Workspace Properties" on
page 57.

Note: For instructions for seing properties on the Layout tab, see "Defining the
Layout of a Workspace" on page 55.
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Note: To update workspace properties you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions to the
workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To set the workspace properties

1. Click Menu on the tab for the workspace and select Workspace Properties.

2. Select the General tab.

3. To change the name of the workspace, type a new name in the Name field.

You can specify from 1 through 255 characters for the name. You can use any
characters, including non-ASCIIs or special characters. The name must be unique
among all your workspaces. If you aempt to assign a duplicate name, My
webMethods appends a suffix to the name, for example, “(2)” to make it unique.

4. Optionally, in the Description field, type a description for the workspace.

You can specify from 1 through 255 characters for the description. You can use any
characters, including non-ASCIIs or special characters.

5. Optionally, in the Keywords field, type one or more keywords to associate with the
workspace. To specify more than one, separate the keywords with a comma.

You can use any characters, including non-ASCIIs or special characters when
specifying keywords. There is no limit to the number of characters you can use in a
keyword.

6. Click OK.

7. Click Menu on the tab for the workspace and select Save Workspace to save your
changes.

For instructions for working with workspace aliases, see Administering My webMethods
Server.

Renaming Workspaces
To rename a workspace you must either be the owner of the workspace, or if you are
using a workspace that another user has shared with you, you must have “View and
Modify” or “Full Control” permissions to the workspace. For more information about
sharing workspaces, see "Sharing Workspaces" on page 62.

To rename a workspace

1. Click Menu on the tab for the workspace and select Rename Workspace.

2. In the Rename Workspace window in the New Workspace Name field, type a name to
assign to the workspace.
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You can specify from 1 through 255 characters for the name. You can use any
characters, including non-ASCIIs or special characters. The name must be unique
among all your workspaces. If you aempt to assign a duplicate name, My
webMethods appends a suffix to the name, for example, “(2)” to make it unique.

3. Click OK to close the Rename Workspace window.

Workspace Sharing
You can share workspaces with other users.

If you have a workspace that contains information that other users might need
to view, share the workspace with those users and grant them “View Only”
permissions to the workspace.

If you have a workspace that other users might want to view, but also can contribute
information, share the workspace with those users and grant them “View and
Modify” permissions.

If you have a workspace and want to allow other users to have full control over the
workspace, share the workspace and grant “Full Control” permissions.

You can share a workspace with individual users, groups of users, or roles. If you grant
permission to a group or role, there might be individual users within that group or role
that you do not want to have access to your workspace. In this case, you can explicitly
deny a user access.

You can have My webMethods send notification to users when you share or stop sharing
workspaces with them by simply selecting an option when performing the procedure
to share or unshare a workspace. My webMethods does not send notification when you
change a permission for an existing user/group/role, only when a user/group/role is
added or removed. For the notification My webMethods sends an e-mail message.

For a user, My webMethods obtains the e-mail address to use from the user’s My
webMethods profile.

For a group, My webMethods obtains the e-mail addresses for each user in the group
from each user’s My webMethods profile.

For a role, if the role has an “email” aribute that specifies an e-mail address for the
role, My webMethods sends the notification to that e-mail address. Otherwise, My
webMethods obtains the e-mail addresses for each member of the role from each
user’s My webMethods profile.

Note: If an e-mail address is not available, no notification is sent, for example, if
a user has not provided an e-mail address in their profile. Also note that if
the “email” aribute is not available for a role, My webMethods only sends
notifications to role members if the role is a Static role; it does not support
sending notification to LDAP Query, Database, or Rule-based roles.
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For instructions for sharing a workspace, see "Sharing Workspaces" on page 62. For
descriptions of the permissions you can assign, see "Workspace Sharing Permissions" on
page 61.

If you grant users “View and Modify” and/or “Full Control” permissions, more than one
user can be working in and updating a workspace at the same time. In this case, if two or
more users make changes to the same window in a workspace, the changes made by the
user who saves last will be the changes that are maintained.

Workspace Sharing Permissions
The following table describes the workspace permissions you can assign to a user when
sharing a workspace.

Permission Use to...

No
Permissions

Explicitly deny a user, group, and/or role permission to take any
action against a workspace, including viewing the workspace.

You might use this permission if you grant access to a group or
role, but want to explicitly deny access to one or more users that
are in the group or role.

Note: The owner of the workspace and all users in the Admin
role, for example, sysadmin, always have Full Control
permissions to a workspace regardless of the actual
permission seings.

View Only Grant users the ability to view a workspace. Users cannot change
the content of the workspace in any way.

Note: When you set the permissions for the workspace, the
same seing is assigned to all the windows within the
workspace. As a result, if you use the “View Only”
permission, all windows in the workspace are also set to
“View Only”, overriding any custom permissions that
have been set for windows within the workspace. If you
want to have a “View Only” workspace, but allow users
to modify selected windows in the workspace, first set the
workspace permission to “View Only”; then assign custom
permissions for the selected windows in a workspace.

View and
Modify

Grant users the ability to view and modify the contents of the
workspace. Specifically, when you grant users this permission
users can:

View the content of the workspace
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Permission Use to...

Update the layout of a workspace

Update the workspace properties

Rename the workspace

Add content to the workspace

Update the properties of windows in the workspace

Rename windows in the workspace

Resize windows in the workspace

Reposition windows in the workspace

Delete windows from the workspace

Full Control Grant users full control over the workspace. In addition to all
the tasks a user can perform when granted “View and Modify”
permissions, the user can also take the following actions against
the workspace:

Share the workspace with other users

Delete the workspace

Sharing Workspaces
Use the following procedure to share a workspace with other users, groups, or roles.

Note: To share a workspace with another user, you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “Full Control” permissions for the workspace.

To share a workspace

1. Click Menu on the tab for the workspace and select Share Workspace.

2. In the Workspace Sharing window click Add.

3. Use the Select Principal(s) window to search for and select the users, groups, and
roles with whom you want to share the workspace. When you are done, click Apply
to close the Select Principal(s) window. For more information about using the Select
Principal(s) window, see "Searching for Users, Groups, and Roles" on page 95.

For each selected user, group, and/or role, My webMethods adds a row to the
Workspace Sharing window.

4. For each user, group, and/or role that you selected, select the permissions you
want to assign that user, group, or role from the list in the Permissions column. For
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more information about the permissions you can assign, see "Workspace Sharing
Permissions" on page 61.

5. If you want to notify the users affected by this change, select the Notify collaborators
when the workspace is shared or unshared check box.

6. Click Apply.

Unsharing Workspaces
Use the following procedure when you no longer want to share a workspace with a user,
group, or role.

Note: To stop sharing a workspace with another user, you must either be the
owner of the workspace, or if you are using a workspace that another user
has shared with you, you must have “Full Control” permissions for the
workspace.

To stop sharing a workspace

1. Click Menu on the tab for the workspace and select Share Workspace.

2. In the Workspace Sharing window, select the check box for the users, groups, and/or
roles with which you no longer want to share access to the workspace.

3. If you want to notify the users affected by this change, select the Notify collaborators
when the workspace is shared or unshared check box.

4. Click Delete.

5. Click Apply.

Closing Workspaces
If you no longer need a workspace open, you can close it. When you need to use the
workspace again, you can re-open it. For instructions, see "Opening Workspaces" on
page 57.

Note: If you no longer need the workspace, you can remove it permanently. For
instructions, see "Deleting Workspaces" on page 64.

To close a workspace

Click Close on the tab for the workspace you want to close, or

Click Menu on the tab for the workspace, and select Close, or

Open the tab finder by clicking  and then click  in the tab finder for the
workspace you want to close.
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Deleting Workspaces
If you no longer need a workspace, you can remove it permanently by deleting it.

Note: If you just want to temporarily close a workspace because you do not need it
open, see "Closing Workspaces" on page 63.

Note: To delete a workspace, you must either be the owner of the workspace, or if
you are using a workspace that another user has shared with you, you must
have “Full Control” permissions for the workspace. For more information
about sharing workspaces, see "Sharing Workspaces" on page 62.

To delete a workspace

On the tab for the workspace, click Menu and select Delete Workspace, or

On the Navigate tab of the navigation pane, right click the workspace name and select
Delete Workspace.

About Adding Workspaces to the Navigation Pane
For easy access to workspaces, you can add them to the Navigate tab in the Workspaces
section of the navigation pane. You can add workspaces that you own and those that
other users have shared with you.

When you no longer need a workspace in the navigation, you can remove it. When you
remove a workspace from the navigation, it is not deleted; the workspace is simply no
longer listed in the navigation pane.

You can organize and group the workspaces in your navigation pane by creating
workspace folders, and then adding the workspaces to your custom folders.

Adding Workspaces to the Navigation Pane
When you add a workspace to the navigation pane, you select the workspace folder in
which you want the workspace to reside.

You can add workspaces to an existing folder, or if you want to use a different folder,
add it before adding the workspace to the navigation pane. You can add the same
workspace to the navigation multiple times if you add it under different folders. For
information about adding folders, see "Adding a Workspace Folder to the Navigation
Pane" on page 65.

To add a workspace to the navigation pane

1. In the navigation pane, click the Navigate tab.
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2. In the Workspaces section, right click the name of the folder in which you want to add
the workspace and select Add Workspace to Folder.

3. In the Select Workspaces window, search for the workspace you want to add:

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against
workspace names and keywords assigned to the workspaces.

b. In the Search In field, select the folders in which to look for matching workspaces.

c. Indicate whether you want to search for only workspaces for which you are the
owner or also those that other users have shared with you.

To search only your own workspaces, select the Include only workspaces I own
check box.

To search all workspaces to which you have access, clear the Include only
workspaces I own check box.

d. Click Search.

4. In the Results panel, select the workspace(s) you want to add the navigation pane.

5. Click OK.

Note: You might need to expand the workspace folder to see the workspaces that
you just added to it.

Removing Workspaces from the Navigation Pane
If you no longer need access to a workspace from the navigation pane, you can remove
it. When you remove a workspace from the navigation, it is not deleted; the workspace is
simply no longer listed in the navigation pane.

To remove a workspace from the navigation pane

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of the workspace that you want to
remove and select Remove Workspace.

Adding a Workspace Folder to the Navigation Pane
To organize and group workspaces in the navigation pane, you can add workspace
folders, and then add workspaces to the folders. When you add a folder, you select a
parent folder for the new folder. The new folder becomes a subfolder of an existing
folder.

To add a workspace folder

1. In the navigation pane, click the Navigate tab.
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2. In the Workspaces section, right click the name of an existing folder and select Create
New Folder.

The new folder will become a subfolder of the selected folder.

3. In the Create New Folder window in the Name of New Folder field, type a name for the
folder.

You can specify from 1 through 255 characters for the name. You can use any
characters, including non-ASCIIs or special characters.

4. Click OK.

Renaming a Workspace Folder in the Navigation Pane
Use the following procedure to rename an existing workspace folder in the navigation
pane.

To rename a workspace folder

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of you want to rename and select
Rename Folder.

3. In the Rename Folder window in the New Name for Folder field, type a new name for
the folder.

You can specify from 1 through 255 characters for the name. You can use any
characters, including non-ASCIIs or special characters.

4. Click OK.

Removing a Workspace Folder from the Navigation Pane
If you no longer need a workspace folder in the navigation pane, you can delete it. When
you delete a workspace folder, My webMethods removes the folder and its content
from the navigation pane. If the folder contains workspaces, those workspaces are also
removed from the navigation. The workspaces ares not deleted; they are simply no
longer listed in the navigation pane.

To remove a workspace folder from the navigation pane

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of the folder that you want to remove
and select Delete Folder.

My webMethods removes the folder and its content from the navigation.
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About Workspace Content
You can add the content that you want to a workspace. Typically, you create a
workspace to have one single location to hold information related to a specific issue or
topic, and add content related to that issue or topic. For example, if you are responsible
for tracking information related to new hires for your company, you might create
a workspace for each new employee. You can aach documents related to the new
employee, add an image of the new employee, add reminders of actions you still need to
take, etc.

As the owner of a workspace, you can take all actions against windows in a workspace.
However, if you are using a workspace that another user has shared with you, your
actions might be limited based on the permissions the owner of the workspace assigned
to you. For example, you might only be granted the permission to view information
and not be allowed to modify it. For more information about sharing workspaces, see
"Sharing Workspaces" on page 62.

Adding Tools to a Workspace
You can add as many tools as you want to a workspace. You can use the same tool
multiple times. For a description of the tools that My webMethods provides as installed,
see "Using Tools to Enhance Workspaces" on page 77.

Note: To add new content to a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To add a tool to a workspace

1. Open the workspace to which you want to add content. For instructions, see
"Opening Workspaces" on page 57.

2. In the navigation pane, click the Tools tab.

3. Drag the tool from the navigation pane on to the workspace in the content area.

4. On the tab for the workspace, click Menu and select Save Workspace.

Adding Windows from Application Pages to a Workspace
You can add windows from application pages to your workspaces. This is useful when
the information in the application pertains to the data you are placing in a workspace.
For example, if you have a workspace to track information about new employees and
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you have a business process in place for managing the tasks related to new hires, you
might add application page windows that are related to the new hire business process.

If the window you want to add to a workspace is wired (connected) to another window
on the application page, My webMethods breaks that connection so that the window can
stand alone on the workspace page. The window keeps its preferences that were set at
the time you added it to the workspace.

For example, if you add a search results window to a workspace, My webMethods
breaks the connection between the search panel and the search results. Its preferences
are set to the search criteria that were used to retrieve the search results. The search
results panel added to a workspace will continue to reflect the results for the search
criteria.

If more items match the criteria, the search results will show more items. If less items
match the criteria, the search results will show less items. However, keep in mind that
My webMethods caches search results. So to update the search results in a tab, you must
take an action that causes My webMethods to update the window on the workspace,
such as closing and re-opening the workspace.

Note: To add new content to a workspace you must be either the owner of the
workspace, or if you are using a workspace that another user has shared
with you, you must have View and Modify or Full Control permissions for the
workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To add a window from an application page to a workspace

1. In the navigation pane, click the Navigate tab.

2. In the Applications section, navigate to the page that contains the window you want
to add to a workspace.

3. In the title bar of the window that you want to add to the workspace, click Tools.

4. Click Add to Workspace.

Note: If a window on an application page cannot function properly outside of its
application page, the Add to Workspace function is not available.

5. In the Add to Workspace window, search for the workspace to which you want to
add content.

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against
workspace names and keywords assigned to the workspaces.

b. In the Search In field, select the folders in which to look for a matching
workspaces.

c. Indicate whether you want to search for only workspaces for which you are the
owner or also those that other users have shared with you.
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To search only your own workspaces, select the Include only workspaces I own
check box.

To search all workspaces to which you have access, clear the Include only
workspaces I own check box.

d. Click Search.

6. In the Results panel, select the workspace(s) to which you want to add the window.

7. Click Add.

Adding Windows from a Workspace to Another Workspace
You can add windows that are in one workspace to another workspace. The window in
the source workspace is not shared with the target workspace. Rather, My webMethods
makes a copy of the window for the target workspace. That is, after adding a window
to a workspace, My webMethods does not synchronize the changes made to the original
version in the source window and the copy in the target window. As changes are made
to the window in the source and target workspaces, they will become different.

Note: To add new content to a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions to the
workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To add a window from a workspace to another workspace

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, navigate to the workspace that contains the source
window you want to add to another workspace.

3. In the title bar of the source window, click Tools.

4. Select Add to Workspace.

5. In the Add to Workspace window, search for the workspace to which you want to
add content.

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against
workspace names and keywords assigned to the workspaces.

b. In the Search In field, select the folders in which to look for a matching
workspace.

c. Indicate whether you want to search for only workspaces for which you are the
owner or also those that other users have shared with you.
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To search only your own workspaces, select the Include only workspaces I own
check box.

To search all workspaces to which you have access, clear the Include only
workspaces I own check box.

d. Click Search.

6. In the Results panel, select the workspace(s) to which you want to add the window.

7. Click Add.

General Properties for a Window in a Workspace
You can open the properties of a window to view or set them. The properties are
grouped on tabs. All windows have a General tab that contains the general properties,
which are described in the table below.

Note: Some windows also have properties listed on a Preferences tab. The
preferences are specific to the window. See information for the specific
window for instructions for viewing and seing preferences.

Section Property Description

Name The name of the window that My webMethods
displays in the window’s title bar.

For instructions for changing the window name,
see "Renaming a Window in a Workspace" on
page 72.

General

Description A description for the window.

Note: Currently the description is only listed
in the properties and is not used by My
webMethods for any specific purpose.

For instructions for changing the window
description, see "Updating the Description of a
Window" on page 73.

Display Full Page
View

This property is intended for expert users. It
defines the presentation (view) to use for the
window when a user enters its URL to navigate
directly to the window.
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Section Property Description

Portlet View This property is intended for expert users. It
defines the presentation (view) to use for the
window when viewing it in a workspace.

Owner The user name of the user that owns the
window.

Created On The date and time the window was added to the
workspace.

Modified On The date and time of the last time the window
was updated.

Maintenance

Aliases This property is intended for expert users. A
window can have zero, one, or more aliases.
An alias defines an alternative way to access
a window. Workspace developers might need
to add aliases if they are building complex
multi-page applications and need to refer
to individual windows, for example, when
creating navigation from one page to another
and need to pass parameters to a specific
window. For more information about aliases,
see Administering My webMethods Server.

Viewing Window Properties
Use the following procedure to view the properties for a window.

To view the properties for a window

1. In the title bar of the window, click Tools.

2. Select Properties.

3. Select the tab for the properties you want to view.

4. Click Cancel to close the properties without making changes.

Renaming a Window in a Workspace
When you add a window to a workspace, My webMethods assigns it a name. You can
change its name by updating the general properties.
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Names of windows must be unique within a workspace. If you add the same window a
subsequent time, My webMethodsappends “(n )” to the name to make the name unique.

Note: To update the properties of a window you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To rename a window in a workspace

1. In the title bar of the window you want to rename, click Tools.

2. Select Properties.

3. Select the General tab.

4. Type a new name in the Name field.

You can specify from 1 through 255 characters for the name. You can use any
characters, including non-ASCIIs or special characters.

5. Click Apply.

6. On the tab for the workspace, click Menu and select Save Workspace.

Updating the Description of a Window
When you add a window to a workspace, by default it has no description associated
with it. You can add a description that appears in the window’s properties.

Note: To update the properties of a window you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To update the description of a window

1. In the title bar of the window for which you want to add or update the description,
click Tools.

2. Select Properties.

3. Select the General tab.

4. Type a new description in the Description field.

You can specify from 1 through 255 characters for the description. You can use any
characters, including non-ASCIIs or special characters.

5. Click Apply.
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6. On the tab for the workspace, click Menu and select Save Workspace.

Finding Windows in a Workspace
As you add many windows to a workspace, it might take time locating the window you
want to use by scanning the workspace. This is especially true if your workspace uses
a free from layout; in this case, windows might be overlapping hiding the window you
want to use. For more information on workspace layouts, see "Defining the Layout of a
Workspace" on page 55.

To locate a specific window and make it the current window, use the window finder. If
the workspace uses a free form layout and the window you want to use is hidden, when
you make a window the current window, My webMethods brings that window to the
front.

To find a window in a workspace

1. In the upper, right corner of the workspace click Window Finder.

2. In the Window Finder, select the name of the window that you want to make the
current window.

Resizing Windows
My webMethods provides many functions to allow you to resize windows within a
workspace. You can:

Minimize a window so that My webMethods displays only the window’s title bar. Use
this function when you do not need to see the content of the window.

Maximize a window so that it uses the full size of the content area. Use this function
when you need more space for a window.

Restore a window to its previous size. Use this function if you previously minimized it
and now want to view its content again, or if you previously maximized the window
and no longer require the window to use the full content area.

Best fit the size of a window so that My webMethods determines the best size to use for
a window.

If you are using a free form layout for the workspace, the window is resized to fit
its contents.

If you are using a column layout (for example, Two Columns), the window resizes
vertically to fit the window contents and horizontally to fit the column width.

Customize the size of a window by dragging the edge of the window to make it any size
you want.
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Note: To resize windows in a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. If you have “View Only” permission to a workspace, you can
resize windows; however, you cannot save the changes. As a result, when you
leave the workspace the windows will revert to their previous state. For more
information about sharing workspaces, see "Sharing Workspaces" on page 62.

To resize a window

To minimize a single window:

In the title bar of a window, click Minimize.

In the title bar of the window, click Tools and select Minimize.

To minimize all windows in a workspace, in the upper, right corner of the workspace click
Window Finder and select Minimize All.

To maximize a window:

In the title bar of a window, click Maximize.

In the title bar of the window, click Tools and select Maximize.

To restore a window:

In the title bar of a window, click Restore.

In the title bar of the window, click Tools and select Restore.

To restore all windows in a workspace, in the upper, right corner of the workspace click
Window Finder and select Restore All.

To automatically resize the window to the best fit, in the title bar of the window, click
Tools and select Auto Size.

To make the window a custom size, drag the edges of the window to the size you want.

Note: If you are using a column layout for the workspace (for example, Two
Columns), and drag a window larger than the column width, the column
width will increase to accommodate the new width of the window.

After resizing windows, save the workspace to keep your changes by clicking Menu on
the tab for the workspace and selecting Save Workspace.

Positioning Windows in a Workspace
Where you can position windows in a workspace depends on the layout you use for a
workspace.

When using a free form layout, you can move windows anywhere within the
workspace. Windows do not have to be aligned and can overlap one another.
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When using a column layout (for example, Three Columns), the layout forces the
windows to be aligned within the columns. You can move windows up and down
within a column or from one column to another.

Note: To reposition windows in a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. If you have “View Only” permission to a workspace, you can
reposition windows; however, you cannot save the changes. As a result, when
you leave the workspace the windows will revert to their previous state. For
more information about sharing workspaces, see "Sharing Workspaces" on
page 62.

To position a window in a workspace

1. In the window you want to reposition, move your cursor over the title bar of the
window until My webMethods displays the move cursor.

2. Click and drag the window to the new location.

3. On the tab for the workspace, click Menu and select Save Workspace.

Deleting Windows from a Workspace
If you no longer need or want a window, you can delete if from the workspace.

Note: To delete windows from a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Control” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

To delete a window from a workspace

In the title bar of the window, click Tools and select Delete, or

In the upper, right corner of the workspace click Window Finder and click Delete for
the window you want to remove from the workspace.

After deleting windows, save the workspace to keep your changes by clicking Menu on
the tab for the workspace and selecting Save Workspace.
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MWS Monitoring and Diagnostics Tools
When you add a tool to a workspace, My webMethods adds a new window to the
workspace that is specific to the added tool. For information about working with
windows in a workspace, see "Working with Workspace Content" on page 67.

Note: To add new content to a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Permission” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

My webMethods provides tools for monitoring and diagnosing. Those tools are
available from the navigation pane, in the MWS Monitoring and Diagnostics section of the
Tools tab.

Important: The following diagnostic portlets are available only with My webMethods
Server 8.2 or later. You cannot use the diagnostic portlets to diagnose My
webMethods Server 7.1.3, or My webMethods Server 8.0.

The following table provides a brief description of each of the tools. For more
information, see Diagnosing My webMethods Server.

Tool Use to...

Log Analysis
Datasource

Read and analyze log files created within My webMethods
Server.

Log Analysis
Time Period

Configure a time period for creating log files within My
webMethods Server.

Log
Configuration

Set the log message collection criteria.

Log Errors by
Severity

Analyze and display logs of WARNING, ERROR, or FATAL
severity.

Log FATAL
Issues

Analyze and display logs only of FATAL severity

Log Issues Analyze and display logs of WARNING, ERROR, or FATAL
severity.



M
Odd Header

Using Tools to Enhance Workspaces

Working with My webMethods Version 9.10 79

Tool Use to...

Log Issues by
Component

Analyze and display logs by the component in which they
appear.

Log Issues by
Product

Analyze and display logs by the product in which they appear.

Log Viewer View the latest messages in plain text log files of My
webMethods Server.

Most Used
Portlets

Display statistics about the ten most used portlets in My
webMethods Server.

Most Used
Web Services

Display statistics about the ten most used Web services in My
webMethods Server.

SOAP Traffic
Monitor

Debug issues with web service calls from other portlets.

Performance
Analysis

Measure and analyze the performance of My webMethods Server
services and custom portlets or applications.

Performance
Statistics

Display statistic and analysis information about the performance
of various My webMethods Server actions which are grouped by
categories.

Slow Database
Calls

Display information about ten of the slowest database calls in My
webMethods Server.

Slow Portlets Display performance information about ten of the slowest
portlets in My webMethods Server.

Slow Web
Services

Display performance information about ten of the slowest Web
services in My webMethods Server.

Http
Information

Provide context information about the Servlet Container for My
webMethods Server.

Memory
Monitor

Monitor the memory usage of the Java Virtual Machine (JVM)
and send notifications to administrators when configured
threshold limits are reached.
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Tool Use to...

Thread Dump Monitor thread execution deadlocks in My webMethods Server
threads.

Workspace Tools
When you add a tool to a workspace, My webMethods adds a new window to the
workspace that is specific to the added tool. For information about working with
windows in a workspace, see "Working with Workspace Content" on page 67.

Note: To add new content to a workspace you must either be the owner of the
workspace, or if you are using a workspace that another user has shared with
you, you must have “View and Modify” or “Full Permission” permissions for
the workspace. For more information about sharing workspaces, see "Sharing
Workspaces" on page 62.

My webMethods provides various tools for workspace enhancement. Those tools are
available from the navigation pane, in the Workspace Tools section of the Tools tab. The
following table lists the tools that My webMethods provides as installed and where you
can find more information about each tool.

Tool Use to... For more information, see...

Attachments Aach files to your
workspace.

"Aachments Tool" on page
81

Bookmarks Add links to workspaces
and web sites.

"Bookmarks Tool" on page
84

Directory
Browser

Find identification
information about other My
webMethods users.

"Directory Browser Tool" on
page 86

HTML Text Add formaed text to a
workspace.

"HTML Text Tool" on page
87

Image Add an image to a
workspace.

"Image Tool" on page 88

Note Add simple, unformaed
text to a workspace.

"Note Tool" on page 90
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Tool Use to... For more information, see...

User Calendar Add a user’s calendar to a
workspace.

"User Calendar Tool" on page
92

Attachments Tool
The Aachments tool allows you to aach files to a workspace. For example, if
you create a workspace to track requirements for a new project, you could use the
Aachments tool to aach documents related to the project.

You can select the type of links to use for aached files by seing the Aachments tool
preferences. My webMethods supports two types of links for aached files:

Simple download links. This is the default. With this type of link, when you click a link
My webMethods displays a read-only version of the file. To make changes to the file,
you need to save a copy locally, make your changes, and then update the aached
file.

Web Distributed Authoring and Versioning (DAV) URLs. With this type of link, when you
click the link My webMethods can typically display a read-write version of the
file. As a result, you can make changes to the file and save them without having
to first save the file locally. To use Web DAV URLs, you must meet the following
requirements:

Use the Microsoft Internet Explorer web browser.

For the types of Microsoft office documents that you want to aach, for
example, .doc or .xls, configure the file type to open in a new Windows Explorer
window. For more information, see Microsoft documentation.

Ensure you have installed all Microsoft Office updates for opening files read/
write in Microsoft Internet Explorer and for using Web DAV URLs. For more
information, see Microsoft documentation.

Attaching Files to a Workspace
When using the Aachments tool to aach files, you can:

Browse to select the files you want to aach.

Drag and drop the documents you want to aach into the aachments window.

Note: You control whether you can aach files using drag and drop by seing
the Aachments tool preferences. For more information, see "Seing
Preferences for an Aachments Window" on page 82.
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After adding the Aachments tool, you can rename the window, reposition it, and resize
it. For more information about managing windows in a workspace, see "Working with
Workspace Content" on page 67.

To attach files to a workspace

1. In the navigation panel, click the Tools tab.

2. In the Workspace Tools section, drag the Attachments tool on to the workspace in the
content area.

3. Aach one of more files by doing one of the following:

Browse for and select files you want to add:

i. In the aachments window, click Add.

ii. In the Aach Files window, click Browse.

iii. Browse to the location of the file to be aached and click Open.

iv. If you want to add an additional file, click Attach Another File and repeat the
steps to aach a file.

v. When you have finished selecting all the files you want to aach, click Save.

Drag and drop files you want to add:

Note: Whether you can use drag and drop is controlled by a property for
the aachments window. You can configure the properties so that
My webMethods does not display the Drop files here box. For more
information, see "Seing Preferences for an Aachments Window" on
page 82.

i. Open a file browser application for your local file system.

ii. In the file browser, browse to the location of the files you want to aach.

iii. Drag the files you want to aach from the file browser into the Drop files here
box in the aachments window in your workspace.

iv. Click Attach.

4. On the tab for the workspace, click Menu and select Save Workspace.

Setting Preferences for an Attachments Window
The Aachments tool preferences control whether My webMethods:

Uses simple download URLs or Web DAV URLs for aached files. Web DAV files
can allow you to make updates to aached files without having to save them locally.
For more information, see "Aachments Tool" on page 81.

Displays the user interface control that allows you to aach files using drag and
drop.
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To set properties for an attachments window

1. In the title bar of the aachment window, click Menu.

2. Select Properties.

3. Select the Preferences tab.

4. To indicate the type of links to use for aached files:

Clear the Use Web DAV urls check box to use simple download links.

Select the Use Web DAV urls check box to use Web DAV URLs.

For more information about the differences between simple download links and Web
DAV URLs, see "Aachments Tool" on page 81.

5. If you do not want My webMethods to display the Drop files here box in the
aachment window, clear the Allow Drag n Drop check box. When this check box is
cleared, you will not be able to aach files by dragging them from the file browser.

6. Click Apply.

Updating an Attachment
You can update the files you have listed in the aachments window.

To update an attachment

1. In the aachments window in the row for the aachment that you want to update,
click 

2. Select Update.

3. In the Update Aachment window, click Browse.

4. Browse to the location of the file you want to use in place of the current file and click
Open.

5. Click Update.

Removing an Attachment
If you no longer want a file aached to the workspace, you can delete it from the
aachments window.

To remove an attachment

1. In the aachments window in the row for the aachment that you want to remove,
click .

2. Select Remove.
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Bookmarks Tool
The Bookmarks tool allows you to add links to:

External web pages

Other My webMethods workspaces

After adding bookmarks to external web pages and workspaces, you have quick access
to them. To view the page or workspace you only need to click a link in the bookmarks
window.

Use the Bookmarks tool to add bookmarks to pages that are related to a workspace. For
example, if you create a workspace to track requirements for a new project and find
several web sites that provide information that you might want to consider, you can use
the Bookmarks tool to add links to the web sites for easy access to the information.

Adding Bookmarks to a Workspace
When using the Bookmarks tool, you can add bookmarks to:

External web pages by specifying an URL to the page.

Other My webMethods workspaces by searching for and selecting a workspace.

After adding the Bookmarks tool, you can rename the window, reposition it, and resize
it. For more information about managing windows in a workspace, see "Working with
Workspace Content" on page 67.

To add bookmarks to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Bookmarks tool on to the workspace in the
content area.

3. To add bookmarks to workspaces:

a. Click Add Workspace.

b. In the Select Workspaces window, fill in the following fields to search for the
workspaces for which you want to add bookmarks.

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against
workspace names and keywords assigned to the workspaces.

b. In the Search In field, select the folders in which to look for matching
workspaces.
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c. Select the Include only workspaces I own check box if you only want to search
for workspaces that you own. Clear the check box if you also want to search
for workspaces that others have shared with you.

d. Click Search.

My webMethods displays matching workspaces in the Results panel.

c. In the search results, select the check boxes for the workspaces for which you
want to add bookmarks.

d. Click OK.

4. To add bookmarks to web pages:

a. Click Add Link.

b. In the Title field, type descriptive text for the bookmark.

c. In the Location field, type the URL for the page you want to bookmark.

d. Click Save.

5. On the tab for the workspace, click Menu and select Save Workspace.

Using the Bookmark Tool to Access Bookmarked Pages
To display bookmarked pages

Click the title of the bookmark in the bookmarks window.

Updating a Bookmark Title or URL
After adding bookmarks, you can update the following:

For a bookmark to a workspace, you can update the title listed for the workspace in
the bookmarks window.

For a bookmark to an external page, you can update the tile and the URL for the
external page.

Additionally, you can update whether the workspace or page opens in the same web
browser window or a new window. For more information, see "Changing Whether a
Bookmark is Opened in the Current or New Window" on page 86.

To update a bookmark

1. In the bookmarks window in the row for the bookmark that you want to update,
click .

2. Select Edit.

3. If you want to change the title My webMethods displays in the bookmarks window,
type a new title in the Name field.



M
Even Header

Using Tools to Enhance Workspaces

Working with My webMethods Version 9.10 86

4. For a bookmark to a web page if you want to change the URL, type the new URL in
the URL field.

5. Click Save.

Changing Whether a Bookmark is Opened in the Current or New
Window
You can select whether you want My webMethods to open a workspace and/or external
page in the current window or in a new web browser window.

To change whether a bookmark is opened in the current or new window

1. In the bookmarks window in the row for the bookmark that you want to update,
click .

2. Select Edit.

3. If you want the bookmark to open in the current window, in the Open Bookmark part
of the panel select the in current window option.

4. If you want the bookmark to open in a new window, in the Open Bookmark part of the
panel select the in a new window option.

5. Click Save.

Deleting Bookmarks
If you no longer need a bookmark to a workspace or external page, you can delete it
from the bookmarks window.

To delete a bookmark

1. In the bookmarks window in the row for the bookmark that you want to delete, click
.

2. Select Delete.

Directory Browser Tool
The Directory Browser tool allows you to find information about other My webMethods
users. The information that you can display is a subset of the identification information
from the My webMethods profile, such as the user ID, full name, e-mail address, instant
messenger user names, etc.

Add the Directory Browser tool to a workspace if you want quick access to the search
window to find user information. For example, if you create a workspace to track
requirements for a new project and need to contact other users in the project, you can
add a directory browser so that you easily find user information for the other users.
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Adding Directory Browsers to Workspaces
To add a directory browser to a workspace, use the following procedure.

After adding the Directory Browser tool, you can rename the window, reposition it, and
resize it. For more information about managing windows in a workspace, see "Working
with Workspace Content" on page 67.

To add a directory browser

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Directory Browser tool on to the workspace in
the content area.

3. Use the directory browser to search for users, groups, and/or roles. For instructions,
see "Searching for Users, Groups, and Roles" on page 95.

4. On the tab for the workspace, click Menu and select Save Workspace.

HTML Text Tool
The HTML Text tool allows you to add formaed text to a workspace. For example, you
can use different font sizes and styles; make text bold, italics, or underlined; use different
colors for the text; highlight text; align text; add a CSS style sheet; use bullet lists and
numbered lists.

Use the HTML Text tool to add text that is related to a workspace. For example, if you
create a workspace to track requirements for a new project you might want to have a
bullet list or numbered list on your workspace to itemize information about the project.

Adding Formatted Text to Workspaces
Use the procedure below to add formaed text to a workspace.

After adding the HTML Text tool, you can rename the window, reposition it, and resize
it. For more information about managing windows in a workspace, see "Working with
Workspace Content" on page 67.

To add formatted text to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the HTML Text tool on to the workspace in the
content area.

3. In the new HTML Text window on the workspace, select the Edit Text link.

My webMethods changes the window to an input mode, displaying the basic
formaing tools at the top of the window.
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4. To view the advanced formaing tools, click Toggle advanced toolbar.

5. Type text in the edit text box using the formaing tools to format the text.

6. Click Apply.

7. On the tab for the workspace, click Menu and select Save Workspace.

Updating Existing Formatted Text
You can update the text in an HTML text window. Use the following procedure to access
the edit mode so that you can update the text.

To update formatted text

1. In the title bar of the note window, click Menu.

2. Select Properties.

3. Select the Preferences tab.

My webMethods displays the text in edit mode.

4. To view the advanced formaing tools, click Toggle advanced toolbar.

5. Update the text in the input text box using the formaing tools to format the text.

6. Click Apply.

Image Tool
The Image tool allows you to add an image file to a workspace. You can add any type of
image file that your web browsers supports, for example, .gif, .jpg, .bmp, or .png.

Use the Image tool to add an image that is related to a workspace. For example, if you
create a workspace to track requirements for a new project you might have an image of a
screen that is related to the project and want to display that on the workspace.

To include text with an image, use the HTML Text tool. For more information about that
tool, see "HTML Text Tool" on page 87.

Adding an Image to a Workspace
When using the Image tool, you can add image files by:

Specifying the URL to an image file.

Uploading an image file that resides in your file system.

By default, My webMethods displays the image using its actual size. However, you can
optionally specify the width and height you want My webMethods to use for the image.
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After adding the Image tool, you can rename the window, reposition it, and resize it.
For more information about managing windows in a workspace, see "Working with
Workspace Content" on page 67.

To add an image to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Image tool on to the workspace in the content
area.

3. In the new Image window on the workspace, select the Click Here link.

4. Identify the image file that you want to add to the workspace:

To identify an image available from an URL:

i. Select the External Url option.

ii. In the Image Url field, type the URL for the image you want to add to the
workspace.

To identify an image located on your machine:

i. Select the Upload File option.

ii. In the Select Image File field, type the path to the image file or click Browse to
select the file.

iii. Click Upload File.

5. If you want to define the size of the image in the workspace, perform the following
steps.

a. In the Image Height field, type the number of pixels (such as, 80px) or the
percentage (such as, 80%) to use for the height of the image.

b. In the Image Width field, type the number of pixels (such as, 80px) or the
percentage (such as, 80%) to use for the width of the image.

Note: If you do not specify the size, My webMethods uses the images actual size.

6. Click Apply.

7. On the tab for the workspace, click Menu and select Save Workspace.

Updating an Image in a Workspace
Use the following procedure to update an image displayed in a workspace.

To update an image in a workspace

1. In the title bar of the note window, click Menu.

2. Select Properties.
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3. Select the Preferences tab.

4. In the Image Properties window, identify the image file that you want to add to the
workspace:

To identify an image available from an URL:

i. Select the External Url option.

ii. In the Image Url field, type the URL for the image you want to add to the
workspace.

To identify an image located on your machine:

i. Select the Upload File option.

ii. In the Select Image File field, type the path to the image file or click Browse to
select the file.

iii. Click Upload File.

5. If you want to define the size of the image in the workspace, perform the following
steps.

a. In the Image Height field, type the number of pixels (such as, 80px) or the
percentage (such as, 80%) to use for the height of the image.

b. In the Image Width field, type the number of pixels (such as, 80px) or the
percentage (such as, 80%) to use for the width of the image.

Note: If you do not specify the size, My webMethods uses the images actual size.

6. Click Apply.

Note Tool
The Note tool allows you to add simple text to a workspace. With the Note tool, you
cannot specify formaing options for the text. If you need more complex text that
requires formaing, such as using bullet lists, using numbered lists, or specifying font
size, style, color, use the HTML Text tool. For information, see "HTML Text Tool" on
page 87.

Use the Note tool to add simple text that is related to a workspace. For example, you
might want to add a short reminder of a task you need to complete for a workspace.

Adding Simple Notes to a Workspace
Use the procedure below to add simple text to a workspace.

After adding the Note tool, you can rename the window, reposition it, and resize it.
For more information about managing windows in a workspace, see "Working with
Workspace Content" on page 67.
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You can also set the preferences for the window to change the background color of the
note and/or add the last update date to the note. For instructions, see "Changing the
Background Color of a Note" on page 91 and "Adding the Last Update Date to a
Note" on page 91.

To add a simple note to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Note tool on to the workspace in the content
area.

3. In the new Note window on the workspace, click the default text, “Enter your text
here”.

My webMethods changes the window to an edit mode.

4. Type the text you want for the note over the existing text.

5. After specifying your text, click outside of the Note window.

6. On the tab for the workspace, click Menu and select Save Workspace.

Changing the Background Color of a Note
You can update the preferences for the note window to change the background color of a
note.

To change the background color of a note

1. In the title bar of the note window, click Menu.

2. Select Properties.

3. Select the Preferences tab.

4. In the Back Ground Color field, select the color you want to use.

5. Click Apply.

Adding the Last Update Date to a Note
You can update the preferences for the note window to add the last date and time the
note was updated.

To add the last update date and time to a note

1. In the title bar of the note window, click Menu.

2. Select Properties.

3. Select the Preferences tab.

4. Select the Show Last Updated Date check box.
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5. Click Apply.

Updating the Text of an Existing Note
You can update the text in a note window. Use the following procedure to access the edit
mode so that you can update the text.

To update the text of an existing note

1. In the note window, click the existing text.

My webMethods changes the window to an edit mode.

2. Type the new text you want for the note.

3. After specifying your text, click outside of the Note window.

4. On the tab for the workspace, click Menu and select Save Workspace.

User Calendar Tool
The User Calendar tool allows you to show the availability of a user by adding the user’s
calendar to a workspace. You can add your own calendar or another user’s calendar.

Note: User calendars will only show information if an administrator has configured
the use of user calendars for the system and if the user’s e-mail address is
configured in the My webMethods profile.

Adding Your Calendar to a Workspace
To add your user calendar to your workspace use the following procedure.

To add your calendar to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the User Calendar tool on to the workspace in the
content area.

By default My webMethods configures the user calendar window to show your user
calendar. To configure the window to display another user’s calendar, see "Changing to
View Another User’s Calendar" on page 92.

Changing to View Another User’s Calendar
To update a user calendar in a workspace so that it displays the calendar for another
user, use the following procedure.
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To change the calendar to display another user’s calendar

1. In the top line of the user calendar window after the user name, click [...].

2. In the Calendar Configuration panel, click Select.

3. Use the Select Principal window to search for and select the user whose calendar you
want to display. For instructions, "Searching for Users, Groups, and Roles" on page
95.

4. After selecting the user, click Apply to close the Select Principal window.

5. In the user calendar window, click Apply.
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About Searching for Users, Groups, and Roles
My webMethods has a standard search panel for searching for users, groups, and/or
roles. Many webMethods applications use this search panel in application pages. Also
My webMethods uses the search panel in workspace tools that require finding a user,
group, or role. The following shows the search panel.

The search panel might have some differences based on the context of the search. For
example:

The Directory field is not always included on the search panel. Also, My webMethods
removes the Directory field when searching for roles.

The Search For field is omied when you can only search for type, for example, only
search for users.

The Advanced tab is not always included. In this situation the search panel is a single
panel with the search fields from the Keyword tab.

Keyword Searches
Use a keyword search to locate users, groups, or roles that contain the keywords that you
specify.

When you initiate a search, you select whether you want to search for users, groups,
or roles, and specify the keywords to use in the search. My webMethods matches the
keywords against user IDs, group IDs, or role IDs based on whether you are searching
for users, groups, or roles.

You can use the following special characters in your keywords:

Embed an asterisk (*) any place within a keyword to match multiple characters. The asterisk
functions as a wildcard character. For example, if you want to locate all groups with
group IDs that contain the leer “b” and “c” with any number of characters between,
type b*c as the keyword.
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Enclose a keyword in quotations (" ") to match an exact string. For example, if you want to
locate all users with user IDs that contain the string “acct”, type "acct". Note that
the search for exact phrases is case insensitive.

My webMethods performs an AND operation on the keywords you specify. In other
words, all keywords that you specify must be present for My webMethods to include
a user, group, or role in the search results. Additionally, My webMethods searches
as if you had enclosed each keyword within asterisks. For example, if you specify the
keyword bbb, My webMethods searches as if you specified *bbb* and returns entries
that:

Are equal to the keyword itself, for example, ‘man’ returns ‘man’

Start with the keyword, for example, ‘man” returns ‘manual’ and “manufacturer’

End with the keyword, for example, ‘man’ returns ‘roman’ and “snowman’

Have the keyword embedded, for example, ‘man’ returns ‘romantic’ and ‘adamant’

My webMethods does not take the order in which you specify keywords into
consideration. It returns matching items regardless of the order in which the keywords
occur.

Performing a Keyword Search for Users, Groups, or Roles
Use the procedure below to perform a keyword search for users, groups, or roles. Based
on the application page or workspace that includes the panel, the procedure might be
slightly different.

To perform a keyword search for users, groups, or roles

1. If the search panel has tabs, select the Keyword tab.

2. In the Search For field, select whether you want to search for Users, Groups, or Roles.

3. If the Directory field is available, select the directory service in which you want
to search for users/groups/roles or select Any Directory to search in all configured
directory services.

4. In the Keywords field, type the keywords that you want to use for your search. For
information about what you can specify, see "Keyword Searches" on page 96.

5. Click Search.

My webMethods displays matching users/groups/roles in the Available list in the
panel.

6. Select the users/groups/roles by moving them to the Selected list.

7. Click Add.
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Advanced Searches
If the search panel includes an Advanced tab, you can use filters for your search. When
you initiate a search, you select whether you want to search for users or groups and then
specify one or more filters. You cannot perform an advanced search for roles.

A filter allows you to specify a field to use for the search and a string value to use for
matching. The Advanced tab of the search panel has a Field Names list that contains the
field names you can use. My webMethods uses Principal Aribute Providers to generate
the list of field names. In the list, bold items identify the name of the Principal Aribute
Provider with the selections generated from that provider underneath.

The field names in the list can differ based on the webMethods components that are
installed. Additionally, developers at your site can create custom Principal Aribute
Providers that can supply field names for the list.

For each filter, when you select a field, you also specify a string value. A user or group
is a match if the field value for that user or group contains the string value that you
specify. The search is case-insensitive.

My webMethods performs an AND operation on the filters you specify. In other words,
all filters must match for My webMethods to include a user or group in the search
results.

Performing an Advanced Search for Users or Groups
Use the following procedure to perform an advanced search for users or groups. Based
on the application page or workspace that includes the search panel, the advanced
search might not be available. When an advanced search is available, the search panel
includes an Advanced tab.

To perform an advanced search for users or groups

1. In the search panel, select the Advanced tab.

2. In the Search For field, select whether you want to search for Users or Groups.

3. If the Directory field is available, select the directory service in which you want to
search for users or groups, or select Any Directory to search in all configured directory
services.

4. In the Filters section of the panel, specify one or more filters. For each filter, perform
the following steps. For more information about filters, see "Advanced Searches" on
page 98.

a. Select a field name that you want to use for the search from the Field Name list.

b. In the Value field, type a string contained in the field value of matching users or
groups.
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c. If you want to add another filter, click Add and repeat the steps to add a filter.

5. Click Search.

My webMethods displays matching users or groups in the Available list in the panel.

6. Select the users or groups by moving them to the Selected list.

7. Click Add.
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About Searching for Data
My webMethods has a standard search panel that is included in many application pages
to allow you to search for various types of data, for example, process instances, KPIs,
etc. In My webMethods the search panels for searching for data do have some slight
differences based on the context of the search. The following shows a representative
sample of a panel used for searching data.

The two main areas of the search panel are the search bar and the search results.

Area of the page Description

search bar You use the search bar to define the criteria My webMethods is
to use to search for information. You can also use it to specify
options that are specific to the page; for example, you can set an
option to have My webMethods automatically execute a saved
search when you access the page.

search
results

My webMethods displays the results of the search in the search
results area, which is below the search panel. The search results
are in either a standard-format table or in a tree format.
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The following table describes the types of searches you can perform, the tab of the search
panel that you use to perform the search, and when the type of search is available for
your use.

Type of
Search

Description Search
Panel Tab

Availability

keyword Search for data that
contains the keywords and/
or exact phrases that you
specify.

For instructions on how to
perform a keyword search,
see "Keyword Searches" on
page 104

Keyword When the keyword
searching is
available depends
on the data being
searched.

basic Search using basic search
criteria when a keyword
search is not available.

Basic Whether basic
searching is
available depends
on the data being
searched.

advanced Search using keywords and
exact phrases along with
additional search criteria to
produce a detailed search
for specific information.

For more information,
see "Basic and Advanced
Searches" on page 106.

Advanced Advanced searching
is only present
when the data being
searched warrants
detailed search
criteria for specific
information.

saved You can re-execute searches
by saving the criteria for
a search. When you save
a search, you provide a
name for the search criteria.
Then when you want to
re-execute the search, you
select the criteria by the
name you assigned it. You
can save and re-execute
keyword and advanced
searches.

For instructions on how
to save search criteria and

Saved Re-executing saved
searches is always
available from the
search panel.
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Type of
Search

Description Search
Panel Tab

Availability

re-execute searches, see
"Saving Your Search" on
page 107

You can set default search options for each My webMethods page that has a search
panel. For example, you can set the tab of the search panel that you want My
webMethods to display when it displays the My webMethods page and whether
you want My webMethods to automatically execute a search when it displays the
My webMethods page. For more information, see "Seing Search Options for a My
webMethods Page" on page 109.

My webMethods displays the results of your search in either a standard-format table
or a tree format. You can customize the display of the search results, for example, you
can select the columns you want included in the display. For more information about
display options and a description of standard-format table and tree format, see "Defining
How My webMethods Displays Search Results" on page 111.

You can take actions against the items in the search result. For example, if your search
was for logged services data, from the search results, you might resubmit a service. For
more information, see "Working with Search Results" on page 113.

Keyword Searches
Use a keyword search to locate entries that contain the keywords and/or exact phrases that
you specify.

When searching for keywords, My webMethods searches across one or more fields.
To determine the fields that My webMethods searches, see "Determining the Fields
that Keywords are Searched Against" on page 105. Keyword searches are not case
sensitive.

You can use the following special characters in your keywords:

Embed an asterisk (*) any place within a keyword to match multiple characters. The asterisk
functions as a wildcard character. For example, if you want to locate all entries that
contain the leer “b” and “c” with any number of characters between, type b*c as
the keyword.

Enclose a keyword in quotations (" ") to match an exact phrase. For example, if you want to
locate all entries that contain the phrase "123 Main Street", type "123 Main Street".
Note that search for exact phrases is case-insensitive.

My webMethods performs an AND operation on the keywords you specify. In other
words, all keywords that you specify must be present for My webMethods to include
an entry in the search results. Additionally, My webMethods searches as if you had
enclosed each keyword within asterisks. For example, if you specify the keyword bbb,
My webMethods searches as if you specified *bbb* and returns entries that:
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Are equal to the keyword itself, for example, ‘man’ returns ‘man’

Start with the keyword, for example, ‘man” returns ‘manual’ and “manufacturer’

End with the keyword, for example, ‘man’ returns ‘roman’ and “snowman’

Have the keyword embedded, for example, ‘man’ returns ‘romantic’ and ‘adamant’

My webMethods does not take the order in which you specify keywords into
consideration. It returns entries regardless of the order in which the keywords occur.

If you do not specify any keywords, My webMethods returns all entries in the search
results up to the defined maximum results allowed. The defined maximum number
of search results for a keyword search is set by My webMethods and is typically 200
results. If you want to define the maximum number of results, use the Max Results or No
Maximum fields on the Options tab. For more information, see "Seing Search Options for
a My webMethods Page" on page 109.

Note: My webMethods searches across a variety of data sources and databases.
Some of the data sources and databases do not allow searches that contain
certain non-alphanumeric characters. If you specify non-alphanumeric
characters in a keyword and the data source or database does not support
searching with those characters, rather than issuing an error and requesting
you retype your keywords, My webMethods continues with the search.
However, My webMethods will replace the non-supported character with a
wildcard character that matches a single character. As a result, your search
results might include additional entries that do not exactly match the search
criteria you specified.

Determining the Fields that Keywords are Searched Against
The fields against which My webMethods matches keywords is different based on the
page you are viewing. Use the Keyword Search Help to determine the fields that My
webMethods will use to find matching entries.

To determine the fields My webMethods searches against

Click or rest your mouse pointer on the Keyword Search Help icon. My
webMethods displays text that lists the fields that it will search against.

Performing a Keyword Search for Data
Use the following procedure to perform a keyword search for data.

To perform a keyword search for data

1. In the search panel, click the Keyword tab.
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2. In the text box, type the keywords that you want to use for your search. For
information about what you can specify, see "Keyword Searches" on page 104.

3. Click Search to initiate the search.

My webMethods displays the results. For more information, see "Defining How My
webMethods Displays Search Results" on page 111 and "Working with Search
Results" on page 113.

Tip: If you will need to perform this search again in the future, you can save
and name the search criteria. Then to re-execute the search, you simply
need to select the search criteria that you want to execute. For more
information, see "Saving Your Search" on page 107.

Basic and Advanced Searches
If the search panel includes a Basic or Advanced tab, you can perform these types
of searches. A basic search is typically available in place of a keyword search. An
advanced search is typically available when a keyword search is available and it
provides additional search criteria to allow you to perform a detailed search for specific
information.

The search criteria fields available for basic and advanced searches vary because
they include fields specific to the page you are viewing. For example, assume My
webMethods is displaying the monitoring Process Instances page, which displays
information about process instances. The Advanced tab on the Process Instances page
includes fields to allow you to search for specific process instances; for example, it
includes a field that you can use to locate process instances that are based on a specific
process model and a field that you can use to locate process instances that have a specific
status (for example, completed status).

Although the search criteria on an Advanced tab is specific to the page you are viewing,
one field that is often included on the Advanced tab is a field to specify a time period, for
example, a date and time range to restrict the search. Typically, this criterion is called
the Range search criterion. The table below provides information about how the Range
search criterion typically functions.

Criteria Description

Range If the data that My webMethods is to search has a time aspect associated
with it, the Range list is available to restrict the search within a specified
time period.

The Range list contains:

Several options that allow you to select a relative time period (for
example, Today, Last 7 days, Last Month)
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Criteria Description

Custom option that allows you to specify an exact time period. When
you select Custom, you must also fill in the Start Date, End Date, and
Times fields to specify the exact time period.

Important: If you use the Custom option to specify an exact time period, My
webMethods returns data within the exact time period that you
specify. If you add the search results to a workspace, the data
added will be static; that is the data displayed will always be for
the exact time period that you specified. If you want the data
to be dynamic, use one of the relative time period options (for
example, Last 7 days). For more information, see "Adding Search
Results to a Workspace" on page 115.

The procedure for performing a basic or advanced search varies based on the page you
are viewing. See the appropriate guide that contains information about the task you are
using.

My webMethods returns all entries in the search results up to the defined maximum
results allowed. The defined maximum number of search results for a search is set
by My webMethods and is typically 200 results. If you want to define the maximum
number of results, use the Max Results or No Maximum fields on the Options tab. For more
information, see "Seing Search Options for a My webMethods Page" on page 109.

My webMethods displays the search results in a table format. For more information, see
"Defining How My webMethods Displays Search Results" on page 111 and "Working
with Search Results" on page 113.

Tip: If you will need to perform this search again in the future, you can save and
name the search criteria. Then to re-execute the search, you simply need to
select the search criteria that you want to execute. For more information, see
"Saving Your Search" on page 107.

Saving Your Search
If you will frequently need to perform the same search, you have the option of saving
your search query. Saving a search query is especially useful when performing
advanced searches that you have constructed with multiple search criteria or search
filters. After you save a search, rather than entering the same search criteria each time
you want to execute the search, you can simply select a saved search and re-execute it.
You can save keyword and advanced searches.

Tip: As an alternative to or in addition to saving a query, if you want immediate
access to your search results, add the results to a workspace. Each time
you display the workspace, the search results will be available. For more
information, see "Adding Search Results to a Workspace" on page 115.
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To save search criteria that you want to re-execute in the future

1. Perform the search that you want to save. For more information about performing a
search, see one of the following:

"Performing a Keyword Search for Data" on page 105

"Basic and Advanced Searches" on page 106

2. Click Save. My webMethods displays the Save Search dialog box.

3. In the Search Name field, type the name you want to assign to the search.

4. Click OK.

Re-executing a Saved Search
Perform the following procedure to re-execute a search that you previously saved.

To re-execute a saved search

1. Click the Saved tab.

2. Select the search you want to re-execute from the Saved Search list.

Tip: If you are unsure of the search criteria for the selected search, click Details.
My webMethods displays the saved search criteria.

3. After selecting the search you want to re-execute, click Search.

Modifying a Saved Search
You can modify the search criteria for a saved search and re-save the search to keep your
modifications.

To modify the search criteria for a saved search

1. Click the Saved tab.

2. Select the search you want to re-execute from the Saved Search list.

3. Click Details. My webMethods displays all search criteria including both:

Search fields that you specified when you saved the search so that you can
change them if necessary. My webMethods displays your current seings in
these search fields.

Search fields that you did not previously set, but might want to set when
changing your search criteria.

4. Make your changes to the search criteria.

5. To save your changes, click Save.
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Deleting a Saved Search
If you no longer need a saved search, you can delete it.

To delete a saved search

1. Click the Saved tab.

2. Select the search you want to delete from the Saved Search list.

Tip: If you are unsure of the search criteria for the selected search, click Details.
My webMethods displays the saved search criteria.

3. After selecting the search you want to delete, click Delete.

Setting Search Options for a My webMethods Page
For each My webMethods page that has a search panel, you can define search options
that apply specifically to that page. These search options can include:

The search panel tab (for example, Keyword or Advanced) you want My webMethods
to display by default when you initially access the My webMethods page

Whether you want My webMethods to automatically execute a search when you
initially access the My webMethods page, and if so, the saved search you want My
webMethods to execute

The maximum number of search results that you want My webMethods to retrieve
before stopping execution of a search

To set search options for a My webMethods page

1. Access the My webMethods page for which you want to set search options.

2. Click the Options tab.

3. To define the search panel tab you want My webMethods to display when you
initially access the My webMethods page, use the Search Tab field. Select one of the
following:

Selection... Description

Keyword My webMethods displays the Keyword tab.

Basic My webMethods displays the Basic tab.

Advanced My webMethods displays the Advanced tab.
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Selection... Description

Saved My webMethods displays the Saved tab.

Saved - Details My webMethods displays the Saved tab with the fields that
show the details about the saved search criteria displayed.

4. To select a saved search to load, and optionally execute, use the Selected Saved Search
field and the Run selected saved search when window is displayed check box:

a. Use the Selected Saved Search field to identify a saved search you want loaded
when you initially access the My webMethods page.

If you do not select the Run selected saved search when window is displayed
check box, which is described in the step below, My webMethods does not
automatically execute the search when you access the My webMethods page; it
will execute the search when you click Search. If you set the Search Tab field to
Saved or Saved - Details, when you initially access this My webMethods page, My
webMethods displays the saved search that you select on this tab.

If you do not select a saved search in the Selected Saved Search field, My
webMethods will not load nor execute a search when you initially access the
page.

b. If you want My webMethods to execute the saved search that you selected
in the Selected Saved Search field, select the Run selected saved search when
window is displayed check box. When you select this check box, My webMethods
automatically executes the selected saved search when you access the My
webMethods page and displays its results, regardless of your seing in the
Search Tab field.

5. To define the maximum number of search results that you want My webMethods to
retrieve before it stops execution of a search, use the Max Results field or No Maximum
check box.

To define a maximum
number of search results

Type a number in the Max Results field. Use Max
Results if you are only interested in the most recent
information. By seing a limit, your searches will run
more quickly and you will receive your search results
faster.

If you want to always view
all search results

Select the No Maximum check box. When you select the
No Maximum check box, your searches can potentially
be long running, and you might have to wait before
My webMethods displays your search results.

6. Click Save to save your search options.
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Defining How My webMethods Displays Search Results
My webMethods displays search results in a table format. The following table lists
the possible display options that might be available for you to use for search results
and where you can find more information about the display option. Whether display
options are available at all and which options you can use depend on the page that My
webMethods is displaying.

Display Option For more information, see

Sort order of search results

Define the default sort order for search
results.

Re-sort search results after My webMethods
initially displays the results.

"Sorting the Search Results" on
page 111

Number of search results rows

Define the number of rows to use for
displaying search results.

"Defining the Number of Search
Results Rows to Display Per
Page" on page 112

Columns displayed

Define the columns to use in the search
results and the order in which the columns
appear.

"Seing the Columns to Display
and Their Display Order" on
page 113

Sorting the Search Results
For each My webMethods page that contains a search panel, you can sometimes define a
default sort order that My webMethods uses when displaying search results. The default
applies specifically to that page. Whether you can specify a sort order depends on the
page. You can determine whether you can set a sort order by the presence of absence of
the sort fields described in the procedure below.

After My webMethods displays search results in your selected default sort order, you
can still re-sort the search results.

To set the default sort order for search results on a specific a My webMethods page

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click Menu and select Properties.

3. Click the Preferences tab.
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4. In the Sort By field, select the column name that you want to use to sort the search
results.

5. For Sort Order select either Ascending or Descending to specify the sort order.

6. Click Apply.

Resorting the Search Results
To re-sort the search results

To re-sort the search results, click  in the column heading of the column that
you want to use to sort the search results. My webMethods indicates the current
sort order by displaying  or  next to the column header of the column that is
currently being used for sorting:

 indicates the results are sorted in ascending order

 indicates the results are sorted in descending order.

For example, if your search results contain a column labeled PROCESS and you want
to sort the data alphabetically based on the process name, click  in the PROCESS
column heading.

Defining the Number of Search Results Rows to Display Per Page
You can set the number of rows that My webMethods displays on each page of the
search results. For example, if a search produces 18 results and you define the number
of rows to display per page as 10, My webMethods displays your results in 2 pages, 10
results on the first page and the remaining 8 results on the second.

Tip: If you want to take the same action against all results from a search, set the
number of rows to show all. Then, you can use Select All to select all items
in the search results, allowing you to act on all items at one time. For example,
you might want to do this if you need to perform a bulk delete of several
items. For more information about acting on search results, see "Taking Action
Against Items in the Search Results" on page 113.

To define the number of search results rows to display per page

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click Menu and select Properties.

3. Click the Preferences tab.

4. In the Number of Rows to Display field, select the number of rows you want My
webMethods to use when displaying search results on this My webMethods page.

5. Click Apply.
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Setting the Columns to Display and Their Display Order
For each My webMethods page, you can customize the columns that My webMethods
displays in the search results. Additionally, you can specify the order in which you want
the columns to appear.

To customize the display of columns for the search results

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click Menu and select Properties.

3. Click the Preferences tab.

4. To specify the columns that you want included, in the Column Display section of the
panel, move the columns to the Selected box.

5. To specify the order in which My webMethods displays the columns in the search
results, move the column names up and/or down in the list.

6. Click Apply to save your column display changes.

Working with Search Results
The following table lists how you can use the search results.

Task For more information, see...

Perform actions against items returned
in the search results. For example, edit
an entry.

"Taking Action Against Items in the
Search Results" on page 113

Add the search results to a workspace. "Adding Search Results to a
Workspace" on page 115

Export the search results to a comma-
delimited text file (.csv file).

"Exporting Search Results to a .csv
File" on page 116

Taking Action Against Items in the Search Results
Typically, you will be able to perform actions against items listed in the search results.
Actions that might be available can fall into one of three categories:

Actions against multiple items in the search results (for example, deleting one or
more items)

Action to add an item
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Actions against a single item in the search result (for example, editing an item or
displaying details about an item)

For information about the actions available in a specific search panel and more details
about how to perform the actions, see the appropriate guide that is associated with the
task.

Taking Action Against Multiple Items in the Search Results
If you can take actions against multiple entries in the search results, My webMethods
displays a function bar at the top of the search results. The function bar contains a buon
for each action you can perform. For example, on the Monitoring > Business > Process
Instances page, there is a Resubmit buon that allows you to resubmit one or more
process instances. In the search results, you mark each process instance that you want to
resubmit, and then click Resubmit.

To act against multiple items in the search results

1. Select the items by selecting their check boxes.

To select all items on the currently displayed page of the search results, click
Select All. To clear all items that you have selected on the currently displayed

page, click Select None.

2. After selecting the items you want to act on, click the appropriate buon (for
example, Delete) in the function bar.

Tip: If you want to take the same action against all results from a search, first
update the number of rows to display in the search results to show all
search results on a single page. Then, you can use Select All to select all
items in the search results, allowing you to act on all items at one time. For
information about seing your preference, see "Defining the Number of
Search Results Rows to Display Per Page" on page 112.

Adding Items
If you can add an item, My webMethods displays a buon you can use to add items in
the function bar. For example, on the Monitoring > System-Wide > Rules > Rule List page,
there is a Create Rule buon. To add a new rule, click Create Rule.

To add an item

Click the add buon, which is typically labeled Add or Create.

If My webMethods displays additional windows, supply the requested information
to describe the new item you are adding.
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Taking Action Against a Single Item in the Search Results
If you can take actions against individual items in the search results, My webMethods
displays action icons in the rows for items. The action icons are displayed on the right
unless you re-ordered the column displays to place them in a different location.

Two common action icons are the Edit icon that you use to edit information for an
item in the search results and the Detail icon that you use to display detail information
for an item in the search results.

To act against a single item in the search results

Click on the appropriate icon for the item you want to act on.

Adding Search Results to a Workspace
You can add the search results to a workspace.

Important: If your search includes a criterion that specifies an exact time period, for
example using the Custom selection of the Range search criterion, when
you add the search results to a workspace, the data is static; that is the data
displayed will always be for the exact time period that you specified. For
more information about the Range search criteria, see "Basic and Advanced
Searches" on page 106.

To add search results to a workspace

1. In the title bar of the window containing the search results that you want to add to
the workspace, click Tools.

2. Select Add to Workspace.

3. In the Add to Workspace window, search for the workspace to which you want to
add the search results.

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against
workspace names and keywords assigned to the workspace.

b. In the Search In field, select the folders in which to look for a matching
workspace.

c. Indicate whether you want to search for only folders for which you are the owner
or also those that other users have shared with you.

To search only your own workspaces, select the Include only workspaces I own
check box.

To search all workspaces to which you have access, clear the Include only
workspaces I own check box.
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d. Click Search.

4. In the Results panel, select the workspace(s) to which you want to add the search
results.

5. Click Add.

Exporting Search Results to a .csv File
You can export search results to a a comma-delimited text file (.csv file) if the search
results panel includes the Export Table function.

The Export Table function exports columns that are hidden (data-only) or rendered on the
screen when those columns are marked as exportable. Columns that are not rendered on
the screen are omied from the output, even when they are marked as exportable.

After exporting search results to a .csv file, you can then import the .csv file into
Microsoft Excel, Microsoft Access, or any other application that accepts the .csv file
format.

To export search results

1. Click Export Table, which is located in the top right of the search results.

2. From the Character Encoding list, select the character encoding to use.

3. Click Export.

4. Click Save to indicate you want to save the search results to a file.

5. In the Save As dialog box, browse to the location where you want to save the .csv
file.

6. Click Save.

Note: To open a .csv file saved with UTF-16 LE encoding in Excel 2000 or earlier,
you will need to import the file using Data > Get External Data > Import Text
File and follow the instructions in the Import Wizard.
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